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Introduction1

Program RWIND1.1

RWIND is an outstanding tool for creating wind-induced loads on general structures. RWIND is a
separate program which is used externally to determine load cases and wind loads for RFEM or
RSTAB models. As for RFEM, the model may consist of beams, surfaces, and/or solids in any
composition. For RSTAB models, loads can be created for models that fully conform to the structural
system, such as lattice towers or braced girders without cladding. RWIND uses a numerical CFD
(Computational Fluid Dynamics ) model to apply a fluid-mechanics simulation of the flow around
objects in a wind tunnel. As a result of the simulation process, specific wind loads are created for RFEM
or RSTAB.

For the simulation, a 3D mesh of finite volumes is used. RWIND performs an automatic meshing, while
the overall mesh density as well as the local mesh refinement near the model can be easily set using
just a few parameters. For the calculation of the air flow and the surface pressure on the model, a finite
volume numerical solver for incompressible turbulent flow is applied. The results are then extrapolated
on the model. RWIND has been designed to work with various numerical solvers. Currently, we
recommend using the OpenFOAM ® software package, which according to our tests gives very
good results and is a widely used tool for CFD simulations. Alternative numerical solvers are under
development.

RWIND is able to read the topology from RFEM or RSTAB models or from *.stl, *.ifc, *.obj and *.vtp
files (importing *.stp and *.igs files is in preparation). Minor corrections of the model that may be
required for corners or joints are applied automatically. The data relevant to the loading can be
defined either in RWIND or in RFEM/RSTAB where a separate window is available. The latter option
is recommended: It enables you to create load cases at equidistant angles and apply velocity profiles
according to specific standards. Effects of turbulence can be included optionally. The dimensions of the
wind tunnel are set to the size of the model but can be modified, if necessary.

The results of the simulation include the pressure and velocity fields around the model, the streamlines,
as well as the surface pressure and the member forces. They represent the results of a stationary
analysis. All results are illustrated by means of color maps (isobands) or isolines on the model or by
slicer planes within the wind tunnel, respectively. The streamlines can be displayed in an animated
view, which makes it easy to evaluate the effects of laminar and turbulent flow. As an essential result of
the simulation, loads are created for the RFEM/RSTAB model. They are exported to the respective load
cases where they are applied as FE nodal loads or member loads. To check the surface loads resulting
from the velocity profile, a special feature is available to display the load distribution in one of the
global or local directions.

The common procedure for creating wind loads with RWIND is as follows:

Define the model data in RFEM or RSTAB.

Open the Simulate and Generate Wind Loads window in RFEM/RSTAB. Define the wind directions
to create the corresponding load cases and specify the wind load parameters to be applied.

Use the [Open in RWIND] function to export the model data relating to one of the load cases to the
RWIND program.

In RWIND, you can review the settings of the wind tunnel, mesh, simplification of the model, and so
on. Adjust the parameters, if necessary.

Start the calculation in RWIND.

Check the results.

Quit RWIND and return to RFEM/RSTAB.

Calculate the remaining load cases, if applicable.

1 Introduction
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Close the Simulate and Generate Wind Loads window. Then set the load case containing the wind
loads created by RWIND.

Inspect the imported loads in the work window and tables.

Combine the wind load case(s) with other load cases in load and result combinations, if applicable.

Finally, start the calculation of the deformations and internal forces.

Find more information in a Knowledge Base article and watch the interaction between RWIND and
RFEM in a webinar .

Apart from the interactive application with RFEM or RSTAB, RWIND can be used as a stand-alone
program for universal CFD analyses. Simply import the model that you have created in your CAD
application and perform the analysis in RWIND. The flow fields, surface pressures, drag forces, etc.
can be utilised for various fields of application, such as an analysis of closely spaced buildings or a
pedestrian wind comfort simulation in a city.

We wish you a pleasant and successful time working with RWIND.

Your Dlubal Software team

RWIND Basic and RWIND Pro1.2

RWIND 2.xx introduces two editions of the program, namely "Basic" and "Pro", that allow you to
choose the optimum license for your needs. The Basic edition is similar to RWIND Simulation 1.xx and
further improves the steady-flow simulations. The Pro edition contains everything that is available in the
"Basic" edition, but also provides new options and features. In RWIND 2.01, it is particularly the
option to calculate transient flow using a more advanced turbulence model (LES). The information
about the active edition is displayed on the title bar of the RWIND window.

You can also check your edition in the license dialog box that you can access by selecting RWIND
License and Authorization on the Help menu.

Image 1.1 Authorization Status dialog box

1 Introduction
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RWIND Team1.3

The following people were involved in the development of RWIND.

Program Coordination

Georg Dlubal, Dipl.-Ing.

Miroslav Šejna, Ph.D.

Jan Pušman, Mgr.

Luboš Pirkl, Ph.D.

Andreas Niemeier, M.Eng.

Programming

RWIND standalone program

Miroslav Šejna, Ph.D.

and PC-Progress s.r.o.

and CFD Support s.r.o.

RWIND interface in RFEM/RSTAB

Miroslav Valeček, RNDr.

Martin Budač, Ing.

Jan Štalmach, Ing.

Quality Management and Documentation

Andreas Niemeier, M.Eng.

Robert Vogl, Dipl.-Ing. (FH)

Lukáš Jurča, Ing.

Jan Pušman, Mgr.

Using the Manual1.4

The chapters of this manual will guide you through the work with the RWIND and RFEM programs.
After a brief theoretical abstract in Chapter 2, detailed information on input, calculation, and results is
given in the following chapters.

In most cases, the described buttons are included in the body of the text. Alternatively, their
descriptions are given in square brackets, for example [View mode]. Expressions that are used in
dialog boxes, windows, and menus are set in italics to clarify the references.

In the PDF manual, you can use the full-text search with [Ctrl]+[f] to find specific expressions. If you do
not find what you are looking for, go to the Knowledge Base or FAQs on our website where you
can search for a solution of the problem.

British English and metric units are used in this manual. You can change the units any time to imperial
settings both in RWIND and in RFEM (see the Chapter 'Units and Decimals' ).

1 Introduction

6

https://www.dlubal.com/en/support-and-learning/support/knowledge-base
https://www.dlubal.com/en/support-and-learning/support/knowledge-base
https://www.dlubal.com/en/support-and-learning/support/faq


RWIND - User Manual

www.dlubal.com

Installation1.5

The installation of RFEM is described in Chapter 2 of the RFEM manual . The system requirements
mentioned there also apply to the RWIND program. See FAQ 4176 for specific hardware settings
recommended for RWIND.

RWIND is available for download as an installation file on our website. Log in to your Dlubal
Account and download the Trial Version of RWIND.

Before installing RWIND, close all applications running in the background.

For the installation, you must be logged in as administrator or have administrator rights. To work with
RWIND later, user rights are sufficient.

Installation Process

Launch the setup.exe file that you have downloaded.

Follow the instructions of the RWIND Setup.

Image 1.2 RWIND Setup dialog box

1 Introduction
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When the installation has finished, start the program to complete the installation and to activate your
licence.

Image 1.3 Message after installation

To change the language of the user interface, activate the Options menu of RWIND.
Then select Program Options to open a dialog box where you can set a different language.

Image 1.4 Selecting language of user interface

1 Introduction
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Licencing1.6

To run the full versions of RWIND and RFEM, both programs must be authorised. This can be
effectuated by software or hardware keys in combination with your personal authorisation codes.

The authorisation process is described in Chapter 2.2.1 of the RFEM manual and on the Support
and Services website of PC-Progress.

To activate RWIND, run the program as administrator. Select [Activate Now] in the dialog box that
appears when the program is started without a valid authorisation.

Image 1.5 Activating RWIND

Then choose the way of activation in the Authorization Status dialog box. The most common option to
activate your Software key is [Activate online].

Image 1.6 Authorization Status dialog box

1 Introduction
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There are various situations concerning licences. They are described on our website as follows:

Software key

Activating trial version online (time-limited, 30 days)
FAQ 4251

Activating full version online (time-limited, up to one year)
FAQ 3595

Activating full version offline by e-mail
FAQ 4278

Deactivating licence online (for moving it to a different computer, or before changing hardware
components)

FAQ 4280

Deactivating licence offline by e-mail
FAQ 4283

Extending licence online before its expiration
FAQ 4292

Hardware key

Local hardware key
FAQ 4247

Network hardware key
FAQ 4247

1 Introduction
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Starting RWIND1.7

There are two options to start RWIND. The program can be either launched directly or applied
indirectly from the RFEM or RSTAB interface.

Program RWIND1.7.1

Double-click the RWIND icon on your desktop to start the program.

Image 1.7 RWIND icon

When you open one of the model examples provided by the installation, the program window will
look as seen in the Image 'RWIND program' . The most important areas of the user interface are
tagged with their descriptions.

Image 1.8 RWIND program

1 Introduction
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RFEM/RSTAB Interface1.7.2

Open a model file in RFEM or RSTAB. Open the Tools menu and then select RWIND - Simulate
and Generate Wind Loads.

Image 1.9 Opening RWIND interface in RFEM

The Simulate and Generate Wind Loads window appears.

Image 1.10 Simulate and Generate Wind Loads window of RFEM

1 Introduction
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Theory2

RWIND is a computer program designed for wind flow calculations around buildings. The software is
able to use external CFD codes in order to perform a CFD simulation and visualise comprehensive
engineering results of wind load acting on the surfaces of buildings.

CFD Solver2.1

The current RWIND version recommends using the external CFD code OpenFOAM®. In particular, a
special, natively compiled OpenFOAM® version from CFD Support called 'OpenFOAM® for
Windows', version 17.10 is utilised. The source code is based on the OpenFOAM® version distributed
via openfoam.org and is included in the installation of the RWIND program.

The numerical solver is called "RWINDSimulationSolver" and it is related to the SIMPLE family of
solvers. It is a steady-state solver for incompressible, turbulent flow, using the SIMPLE (Semi-Implicit
Method for Pressure Linked Equations) algorithm.

Since OpenFOAM® is distributed under the GNU GPLv3 licence, the RWINDSimulationSolver is
distributed under the same licence and its source code can be found in the RWIND installation
directory, subdirectory 'OF\src'. For more information about OpenFOAM®, visit the CFD Support
website or contact CFD Support directly using support@cfdsupport.com . Trademark disclaimer:
This offering is not approved or endorsed by OpenCFD Limited, producer and distributor of the
OpenFOAM software via www.openfoam.com , and owner of the OPENFOAM® and OpenCFD®
trade marks.

The result of the calculation is a three-dimensional field of velocity and pressure covering the entire
computational domain, i.e. the wind tunnel. Pressure values on the model boundary (exterior surfaces
of buildings) are then used to calculate the forces representing the wind load.

The used methods theoretically allow for a very precise simulation of such flow, provided that the
computational mesh is sufficiently fine (for example, tens of millions of mesh cells). However, such
calculations are very time-consuming and thus expensive. Furthermore, the preparation of such
calculations, i.e. topology clean-up and generation of an optimal mesh, often requires considerable
effort and experience. RWIND has thus been designed to be very easy to use and to get approximate
results on relatively coarse meshes in a very short time, typically within several minutes. If greater
accuracy is desired, the user can obtain more precise results by increasing the mesh density – the
capacity and performance of RWIND is limited only by the available memory and the number of
processors/cores used for the parallel calculation.

Computational Mesh and Model
Simplification

2.2

To generate a finite volume mesh, the model must be topologically correct. In RWIND, model
boundaries are defined by triangles, and the term 'topologically correct' then means that these
triangles must form a closed triangular mesh: Each mesh edge has exactly two adjacent triangles, and
that the triangles must not intersect or touch each other except common edges. In fact, the exact
definition of a "topologically correct" model is more complicated, but we do not want to go into all the
details here.

The problem is that CAD models are usually not topologically correct – triangles of a 3D object often
intersect with triangles of another object, the model boundary is not closed, and so on. The
pre-processing of such models for CFD analysis can be very extensive and require 60-80% of an

2 Theory
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engineer’s time. Facilitating this work was therefore one of the main goals in the development of
RWIND, which has been achieved by implementing the so-called simplified model. The simplified
model actually represents a special mesh "shrink-wrapping" the original model. This mesh is
topologically correct and can therefore be used as a model boundary for the generation of a 3D finite
volume mesh. The simplified model will automatically correct most of the problems that would
otherwise have to be corrected manually. Those include:

Model simplification (see point 1 in Image 2.1 ): Details that are not relevant to the given
simulation and could cause calculation instability due to insufficiently fine discretization are
simplified.

Intersection of triangles (see point 2 in Image 2.1 )

Open edges and surfaces with zero thickness (see point 3 in Image 2.1 )

Closing openings to prevent the air from flowing into the interior of the building (see point 4 in Image
2.1 )

Image 2.1 Topological imperfections of CAD models

Image 2.2 shows some examples of automatically simplified models.

2 Theory

14



RWIND - User Manual

www.dlubal.com

Image 2.2 Simplified models

When simplifying the model, it is possible to specify the level of detail as well as the maximum size of
openings to be closed. Using a simplified model to determine the wind load on a building is based on
the following assumption: if the simplified model approximates the shape of the original model well, the
load calculated for the simplified model will also be close to the correct values.

Though we expect the use of a simplified model to be the most common choice, the user can turn off
this option and calculate with the model boundaries as they were imported. However, this option is
only recommended for advanced users experienced in CFD analyses.

2 Theory
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Wind Speed Profile2.3

Wind loads are climatic loads on buildings representing variable actions. They result from the pressure
distribution around the building which is subject to wind flow. In general, wind loads are applied as
surface loads which act perpendicularly on the surfaces featuring compression and suction effects.

The wind loads are regulated in specific standards, such as EN 1991-1-4 [1] , ASCE/SEI 7-16
[2] , or NBC 2015 [3] . In the Eurocode, the application area is specified for buildings with heights
up to 200 m. This limit may be increased to 300 m for wind profiles valid according to the German
National Annex, for example.

In the standards, the wind loads are converted into characteristic values so that the load capacity of
buildings can be determined. As those loads represent actions that vary over the time and the
geometry, their distinct stochastic characteristics are accounted for by those values.

For the design values, both the location of the building with its local wind climate and the surrounding
topography are essential. The wind climate is recorded in the standards via wind zone maps. In EN
1991-1-4 [1] , for example, the fundamental basic wind velocities are given. They represent average
values determined over the time when the wind takes effect. For detailed information on the wind
zones according to administrative borders, the Dlubal Geo-Zone Tool can be used to comfortably
obtain the values of the basic wind velocity vb,0 and of the velocity pressure qb.

Image 2.3 Determining wind velocity with Dlubal Geo-Zone Tool

A Knowledge Base article describes in detail how wind loads on mono- and duopitch roofs are to
be considered according to EN 1991-1-4 [1] in Germany. In another Knowledge Base article ,
you can find an example how to apply wind on vertical walls.

The standards provide information on how to apply wind loads on buildings featuring mainly
rectangular shapes. RWIND, however, is able to determine the surface pressure and wind velocities
for buildings with any kind of shape. The fundamental (or mean) wind velocity is applied to determine
the specific loads of a building – with or without interaction with other buildings – by a numerical

2 Theory

16

https://www.dlubal.com/en/load-zones-for-snow-wind-earthquake/wind-bs-en-1991-1-4.html#center=54.91516987102085,-3.9617111837426666&amp;zoom=6&amp;marker=53.64534200110513,-1.69033249757058
https://www.dlubal.com/en/load-zones-for-snow-wind-earthquake/wind-bs-en-1991-1-4.html#center=54.91516987102085,-3.9617111837426666&amp;zoom=6&amp;marker=53.64534200110513,-1.69033249757058
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001554
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001554
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001554
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001564
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001564
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001564


RWIND - User Manual

www.dlubal.com

wind tunnel simulation. If the wind velocity is defined individually for each level height of the model, the
simulation can also be carried out for standards other than EN 1991-1-4 [1] or independently of
any code.

The wind profiles described in EN 1991-1-4 [1] also account for the ground roughness. With the
character of the terrain, specific turbulence effects near the ground level and, thus, reduced velocities
are associated. EN 1991-1-4 [1] , Table 4.1 gives the corresponding terrain categories. Those
turbulence effects are different from the turbulences due to the shape of the building. They are
described in the following chapter.

Turbulence2.4

Turbulence is one of the most complicated phenomena observed in nature, making its precise definition
difficult. Literature gives many definitions, as, for example, the one included in [4] : "A fluid motion is
described as turbulent if it is three-dimensional, rotational, intermittent, highly disordered, diffusive and
dissipative."

Image 2.4 Turbulence illustrated by streamlines on RWIND model

In order to fully capture the turbulence by numerical modelling, one has to solve the equations of
motion for fluid flow on all spatial and temporal scales. This approach is referred to as "direct
numerical simulation" (DNS). For industrial applications, the computational resources required by a
DNS far exceed the capacity of the most powerful supercomputers currently available.

Instead, RWIND uses a different technique where flow variables, such as velocity or pressure, are
decomposed into mean (averaged) components and fluctuating components. In other words,
governing equations of fluid motion are averaged in order to remove the small scales, resulting in a
modified set of equations that are computationally less laborious to solve. Those equations are
referred to as "Reynolds-averaged Navier-Stokes equations' (RANS).

In order to solve RANS in RWIND, the k–ε turbulence model [5] is used, which introduces two
transport equations for the turbulence properties: the first one is the transport equation of the turbulence
kinetic energy k, and the second equation governs the transport of the dissipation rate ε of k. This
method represents the most widely used and tested model for CFD calculations. Robustness, economy,
and reasonable accuracy for a wide range of turbulent flow applications explain its popularity in
industrial flow simulations.

2 Theory
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Simulation of Transient Flow2.5

Difference Between Steady and Transient Flow

The steady-flow calculation seeks a numerical solution of the simplified Navier-Stokes equations,
describing a flow field that does not change over time.

However, the current wind flow around buildings is often not stationary as there are turbulent
vortices around and behind the buildings that keep changing over time. A typical example is the
Kármán vortex street. It is a repeating pattern of swirling vortices that is caused by a process known as
vortex shedding which is responsible for the unsteady separation of the fluid flow around blunt bodies.
For simulations of this type, RWIND uses another solver, namely the BlueDyMSolver, developed by
CFD Support from the standard OpenFOAM solver called PimpleFoam.

2 Theory
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Input Data3

Project Management3.1

The model files created by the RWIND program are called 'Projects'. The Project Manager helps you
to organise all projects.

To open the Project Manager, select File Project Manager on the menu or use the button in
the toolbar.

The Project Manager consists of two tabs in which the Project Groups and the contained Projects are
managed.

Project Groups

Image 3.1 Project Manager, Project Groups tab

The first tab lists all project groups that have been created by the installation (Demo), by Dlubal
applications (RFEM/RSTAB) or by yourself. You can see the Description and Path of every project
group. The current project group is highlighted. To change the project group, double-click the relevant
line.

Use the [New] button to create a new project group. Then specify the Name, Description and
Directory of the project group in a dialog box (see the Image 'New Project Group' ).
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Image 3.2 New Project Group

Projects

Image 3.3 Project Manager, Tab Projects

The current project group is set as default. You can select a different project group in the list if you want
to manage a new project in some other folder.

In the table, all projects contained in the current projects are listed. You can see their names,
descriptions, existing results, sizes, and dates of modification. To sort the arrangement in a different
manner, click the corresponding table header.

Projects in the RFEM/RSTAB project group have special project (file) names, for example,
'2DCB5BCB-58BA-4E63-B8B3-0F8772B1F44F.rws1'. They are needed to identify projects
unambiguously. To make the projects table more user-friendly, 'Alias' project names are displayed. Do
not change the original file names since this could cause inconsistent data exchange between RWIND
and RFEM/RSTAB.

Below, you see a preview of the selected project and its details.

To open a project, double-click it in the list. You can also select it and use the [Open] button.

Use the [New] button to create a new project. Then specify the Name and Description of the project in
a dialog box (see the Image 'New Project' ).
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Image 3.4 New Project

The current project group is preset.

The Import model from file option enables you to import data via an interface. If you want to create the
model by yourself, however, clear this check box.

Click [Next] to open the following dialog box. It appears when a model is to be imported.

Image 3.5 Import Model

When the Import model from file option has been selected, you can specify the file type in the Import
Model dialog box. Currently, RFEM/RSTAB data (file format *.vtp), Stereo Lithography files (*.stl),
Wavefront OBJ files (*.obj), and Industry Foundation Classes files (*.ifc) of version 2x3 are supported.

Many 3D programs, such as Autodesk Revit or SketchUp, provide the option to export models to the
STL file format. RWIND can thus be used independently of RFEM or RSTAB to perform general CFD
analyses and determine the flow fields, surface pressures, drag forces, and so on, of all sorts of
models. Load forces will not be created for RFEM/RSTAB, though.

Set the File path and the Length units. Make sure that the Z-axis is in accordance with the settings in
RFEM/RSTAB.

In the Options section, you can decide whether the model is to be moved to the origin. Furthermore,
the wind tunnel dimensions can be automatically adjusted to the size of the model.

Click [Finish] to import the model file.

If the model is to be created in RWIND (instead of being imported from a file), clicking [Next] in the
'New Project' dialog box opens the following dialog box.
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Image 3.6 Wind Tunnel

You can define the dimensions of the wind tunnel by means of six parameters. The dimensions in X, Y
and Z refer to the origin. Make sure that the wind tunnel is large enough around the model, notably the
area behind it.

The Lower boundary condition applied to the bottom surface of the wind tunnel is set as smooth surface
by default. The surface roughness can be controlled by the material properties defined for the surface
at the tunnel floor. When you select the Slip option from the list, however, the influence of the bottom
plane is deactivated, i.e. as if the model was far off the ground. You can then analyse parts of a
building, for example the top of a tower, without defining the entire object.

It is recommended to adjust the work plane grid to the size of the wind tunnel.

Click [OK] to create the new project and start working.

The Project Manager cannot be left open in the background as a stand-alone application while you
work with RWIND.
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Imported Models3.2

At the present stage, models for RWIND can be created in RFEM or RSTAB, or imported from an STL
file (e.g. terrain and other objects). The wind loads applied in specific directions (see description
below ) result in corresponding load cases. Each direction represents one model in RWIND. After the
calculation, the models are saved in the 'RFEM/RSTAB' project group. For the analysis, the models are
exported to RWIND where the loads are determined. The denominations of each model (Project)
include the names of the RFEM/RSTAB models and the load case numbers.

Image 3.7 RFEM Models in Project Manager

You can open any RFEM or RSTAB model to examine the results. Additionally, you can modify the
calculation parameters, move or rotate the model, or insert the geometry of the terrain (in development,
see the Chapter 'Model Type' ).

If you have launched RWIND from RFEM or RSTAB and want to save the model under a different
name, use the Save Copy As function in the File menu. Save As might disconnect the project from
RFEM/RSTAB and cause an error.
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Wind Tunnel3.2.1

You can modify the dimensions of the wind tunnel in a dialog box or graphically. To open the dialog
box, double-click the Wind Tunnel item in the Data navigator or open the Edit menu, point to Wind
Tunnel and select Edit Wind Tunnel.

Image 3.8 Dialog Box Wind Tunnel

The size of the wind tunnel is defined by means of six parameters; the dimensions in X, Y and Z refer to
the origin of the model. The [Adjust Automatically] button enables you to set the size to the default
dimensions. Depending on the model type (open framework or closed surfaces), they are determined
from the YZ-projected area of the model. The 'free space' around the model – which in reality is
unlimited – is then set large enough with respect to that projected area.

The Lower boundary condition applied to the bottom surface of the wind tunnel is set as smooth surface
by default. When you select the Slip option from the list, however, the influence of the bottom plane is
deactivated. This option enables you to analyse parts of the model, for example the top of a tower,
without defining the entire building. Alternatively, the surface roughness can be controlled by the
material properties defined for the surface at the tunnel floor. It is recommended to adjust the work
plane grid to the size of the wind tunnel.

To modify the wind tunnel graphically, click the Resize Wind Tunnel item in the panel. Make sure that
the Model tab of the work window is set.

Image 3.9 Graphical Adjustment of Wind Tunnel
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In the same way as described above, it is possible to enter the dimensions of the wind tunnel in the Edit
Bar panel. Additionally, you can modify its size in the work window by selecting one of the arrows and
moving it. The corresponding parameters are updated in the panel.

When you hold the [Shift] key while moving an arrow, the wind tunnel is modified symmetrically in the
respective direction. By holding the [Ctrl] key, you can scale the wind tunnel up or down uniformly in
all three directions.

The default dimensions of the wind tunnel are set as small as possible to obtain short calculation times.
If the simulation is divergent, one of the reasons may be that the length of the wind tunnel in X-direction
is too short, especially the area behind the object. You should then extend the wind tunnel accordingly.

Simulation Parameters3.2.2

The parameters of the fluid dynamics analysis are managed in a dialog box containing several tabs.
You can open this dialog box by double-clicking the Simulation Parameters item in the Data navigator
or by clicking the Simulation Parameters item in the panel.

General3.2.2.1

Image 3.10 Simulation Parameters dialog box, General tab

Flow Parameters

The Inlet velocity represents the wind speed entering the wind tunnel. The [Profile] button enables you
to define the wind speed as a function of the height. You can enter the chart values as described in the
Chapter 'Wind Profile' below. The value of the Kinematic viscosity describes the resistance of the air
against deformation. It is defined as the ratio of the viscosity to the Density of the air.
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Finite Volume Mesh

The Mesh density to be applied around the model is controlled by percentage reference. This specific
refinement is utilised for the model simplification and the flow calculation. The default density (20%)
normally results in a relatively low number of finite volume mesh cells and a relatively fast calculation.
The minimum percentage is 10%. It entails a rather coarse mesh with the smallest number of volumes.
The higher the density of the mesh, the smaller the size of the finite volume cells will be. The results are
accordingly more precise, but the calculation will need more time due to the greater number of
volumes. Setting the maximum mesh density (100%) leads to very fine meshes with millions of volumes.
The calculation of 3D flow on such meshes is on the edge of the capabilities of current PCs, with a
calculation time of several hours to several days.

You can enter the mesh density or modify it with the slider. The Mesh cell estimation below gives the
corresponding number of finite volume cells and the minimum cell size.

For further information, see the Chapter 'Computational Mesh and Model Simplification' .

The Mesh refinement type can be defined for curvatures of the surfaces (fine mesh only close to sharp
edges of the model) or globally for a distance from the surfaces (fine mesh on entire boundary
surfaces). The first option is set as default because it produces meshes with a lower number of finite
elements.

The Boundary layers option controls whether the finite volume mesh next to the surfaces of the model is
refined in a special way. This refinement gives better results near the boundaries of the model. As the
number of finite volumes is increased considerably by the layers of small volumes, however, the option
is disabled by default. It is highly recommended to activate the boundary layers and define the number
of layers NL, however, when the surface roughness is to be taken into account.

Image 3.11 Finite Volume Mesh with Five Boundary Layers near Surfaces

The Snap to model edges option enables you to align the mesh with the borders of the model. Please
note that this option is only available when the model simplification is off.
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Steady Flow3.2.2.2

The steady flow calculation can be selected on the General tab of the Simulation Parameters<i> dialog
box (see the Image 'Simulation Parameters' ).

Image 3.12 Simulation Parameters dialog box, Steady Flow tab

Initial Condition

If activating the Use potential flow to calculate initial condition option, a linearised version of the
non-viscous Navier Stokes equations is used to generate the start conditions.

Steady Flow Calculation

You can define the Maximum number of iterations. By default, the limit is 500 iterations. If the
calculation converges within less iterations, it is stopped. Note that a minimum number of 300
iterations is carried out by default (see the Image 'Program Options' ), regardless of whether the
convergence criterion (see below) has already been met. The maximum number is useful to avoid
infinite loops.

The Convergence criterion represents the stop limit for the calculation. As soon as the residual pressure
has fallen below the defined value, the calculation is terminated. The diagram of iterations and residual
pressure is shown during the calculation. It is also available in the simulation results (see the Chapter
'Residual Pressure' ).
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Image 3.13 Diagram of Iterations and Residual Pressure Shown During Steady Flow Calculation

Solver

The steady-state solver of RWIND does not fully capture the "oscillating" effects as described in FAQ
4731 . In order to solve the partial differential equations numerically, all differential terms (space
and time derivatives) have to be discretized. There is a vast list of discretizations ('schemes'), with each
scheme having its particular numerical behaviour in view of accuracy, stability and convergence.

The Use second-order numerical scheme check-box controls which numerical scheme is used for
divergence terms (fluxes). It is not activated by default so that the calculation is carried out according
to first order. If the check box has been selected, the solution is performed according to second order.

Basically, the order of the scheme indicates how accurate the numerical solution when compared to
the solution of the original non-discretized equations is: The first-order numerical discretization
generally yields better convergence than the second-order scheme. In contrast, the second-order
discretization is usually more accurate.

Continue Calculation and Reopening

RWIND 2 provides a new option to continue the calculation of a given project even after the
calculation is interrupted and the project is closed. To be able to continue the calculation even after the
project is closed and to open it again, you need to select the Save the solver data to continue
calculation option. This must be done before saving the project data while the data still exist in the
working directory, that is, after the calculation has just been finished.

Transient Flow3.2.2.3

The Transient Flow calculation can be selected on the main page of the dialog box with the simulation
parameters. We can also choose whether to display instant results during the calculation.
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Image 3.14 Dialog Box Simulation Parameters, Tab General

The transient flow parameters can be defined on the Transient Flow page.

Image 3.15 Dialog Box Simulation Parameters, Tab Transient Flow

This dialog box section controls the parameters of the transient flow simulation.
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Initial Condition

In this section, it is possible to set the calculation of the initial conditions using the steady state solver,
which is the recommended option. We can also define the number of iterations for this calculation. If
this option is turned off, a constant current field is used as the initial condition.

When calculating the transient flow, it is important to set the initial condition correctly. Improperly set
initial condition can cause either instability of the calculation or unnecessarily long calculation time
before the flow field stabilizes at the correct values. RWIND uses its steady-flow solver with a low
number of iterations to calculate the initial condition. This means, when calculating the transient flow,
the steady-flow calculation of the initial condition is started first, and as soon as it is finished, the
transient calculation is started automatically.

Transient Flow Calculation

In this section, we can set the calculation time and the optimum time-steps for saving the transient
results. The default setting is recommended; more experienced users can change this setting at their
discretion, but it is important to realise that the inappropriate settings may cause a large amount of
data to be stored on disk (tens or hundreds of GB), which may significantly slow down the calculation
as well as the subsequent work with the program.

The Simulation time is the real time of the wind flow we want to calculate. The default value (given by
the automatic setting) corresponds to 10-multiple of the time required for the wind to pass through the
entire length of the tunnel at a given inlet speed.

Start time for saving results is the time from which transient results are to be stored. It allows to avoid
storing data in the initial phase of the calculation, in which the numerical solution does not yet have the
correct values.

Furthermore, there is the information on the existing results: simulation time achieved, number of time
layers of results stored in point probes (PTL) and in the whole computational area (DTL).

Saving Results

This section contains the options for saving the results of animations, graphs and transferring the result
time layer to RFEM. There is a switch for storing transient results in the entire computational domain (in
the nodes of the computational mesh) and the time step after which these data are stored. These results
are used for the animation of transient flow and for the graphs of the time-development of drag forces
and other quantities in the point probes defined after the calculation. The data can be very large and
can take up tens or hundreds of GB on the disk. This should be considered when choosing the time
step. The NTL number indicates the total number of time layers for these data.

There is also a switch for storing transient results in point probes defined before the calculation and the
time step after which these data are stored. These data are much smaller than the transient results in the
whole domain and allow you to obtain the information about the time development of quantities with a
finer time step. The NTL number indicates the total number of time layers for these data.

The Master time layer is the main time layer whose results are exported to the RFEM / RSTAB program
for structural load calculations. By default, the last time layer is set as the Master time layer, but the
user can change this value either in this dialog box or from the pop-up menu accessible to the edit bar.
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Image 3.16 Option Edit Object, Time Layer

Lastly, there is a parameter for setting the error-tolerance when compressing the data of the transient
results: Data compression error tolerance. The data of transient results can be huge, and thus RWIND
allows for their compression, which can, however, introduce a certain error into some time layers. This
tolerance indicates how much the value at a given point can differ from the value obtained from the
calculation.

The default tolerance is set to 0.1%, which means the value eps = 0.001 * (Vmax - Vmin), where Vmax
and Vmin is the maximum and the minimum value of the given quantity in the whole domain. If we set
the tolerance to zero, the compression is not performed and all values in all time layers correspond to
the values obtained from the calculation.

Other Options

The Save the solver data to continue calculation checkbox allows you to save additional data needed
to continue the calculation after closing the project and then reopening it. By default, this option is
disabled to save the data stored in the project file.
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Wind Profile3.2.2.4

Image 3.17 Dialog Box Simulation Parameters, Tab Wind Profile

This tab controls the parameters of the wind speed and/or turbulence intensity that are applied to the
model. When the model has been imported from RFEM or RSTAB, the wind profile in compliance with
the selected standard is shown.

Wind Profile Type

Select the Profile type that is to be defined: Wind Speed or Turbulence Intensity. You can then create
the profile by defining its Relative or Absolute values in a table (see Section 'Wind Profile Values'
below). With the Relative option, the reference value 1 corresponds to the inlet velocity defined in the
General tab or to the turbulence intensity specified in the Advanced tab, respectively. You can then
define the Factor of each height level in the Wind Profil Values table. When the Absolute option is set,
you can enter the values of the wind speed or the percentages of the turbulence intensity directly. The
header of the table below is changed to Speed or Turbulence, respectively.

Wind Profile Values

To define the wind speed or turbulence intensity at specific height levels in this table, enter the Number
of rows required and click [Apply]. Then you can define each Height and allocate the Factor, Speed or
Turbulence (depending on the option selected above). As an alternative, you can paste the values of
an Excel sheet. Click the [Refresh Chart] button to display the Wind Speed or Turbulence Intensity
diagram of your data.

The [Constant] button creates a uniform wind profile for the entire model. Only two table rows are
needed.

If you use the [Generate] button to create a wind speed profile, a new dialog box is opened.
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Image 3.18 Dialog Box Generate Wind Profile

Define the height of the profile and the number of intermediate points. You can select between a
logarithmic and a linear type of the profile. Enter the height at which the inlet velocity (defined in the
General tab) is applicable. Finally, select the relevant landscape type to define the roughness of the
terrain: small towns and villages, large towns with high buildings, or large cities with skyscrapers. Then
click [OK] to generate the wind speed profile.

In the 'RWIND window' of RFEM/RSTAB, you have advanced options to create wind profiles
according to specific standards (see the Chapter 'Wind Load' ).

Turbulence3.2.2.5

Image 3.19 Dialog Box Simulation Parameters, Tab Turbulence

Turbulence Parameters

In this section of the dialog box, you decide whether you want to Consider turbulence. The effects of
turbulent flow are characterised by chaotic changes of pressure and flow velocity (see the Chapter
'Turbulence' ), in contrast to laminar flow. As the air represents a 'fluid' with low viscosity, excessive
kinetic energy overcomes the damping of the fluid in the areas with increased velocity.
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The Model of turbulence can be based on the correlations between k and epsilon or between k and
omega. The first option is set as default. Depending on the selection (see the image to the left), you can
specify either the turbulent dissipation rate ε or the specific dissipation rate ω. In general, the simulation
using kω is more universal and more robust than the one using kε. Nevertheless, the kε model of
turbulence gives better results for specific locations, such as the zones close to surfaces.

If you select the Calculate k-ε parameters from the intensity of turbulence option, you can define the
intensity I as a percentage (a ratio of root-mean-square of the turbulent velocity fluctuations and the
averaged velocity at the same location over a time period) in the text box below. The [Profile] button
allows you to define the turbulence intensity as a function of the height. You can enter the chart values
as described in the Chapter 'Wind Profile' above. The turbulent kinetic energy k and the turbulent
dissipation rate ε (or the specific dissipation rate ω, respectively) are then determined by the program.
As an alternative, you can define the parameters k and ε (or ω) manually as soon as you have cleared
the option mentioned above.

An idealised flow of air with absolutely no fluctuations in the air speed or direction would have the
turbulence intensity value of 0%. For the high-turbulence cases, the turbulence intensity is usually
between 5% and 20% (see CFD Online ). The turbulence intensity is set to 1% by default to cover
most medium- and low-turbulence cases.

LES Turbulence Model

The transient calculation allows for the utilization of more advanced LES turbulence models. So far, one
model is only available in RWIND 2.01, namely Spalart-Allmaras DDES. More information about this
model can be found, for example, on the CFD Support website (www.cfdsupport.com ) or on
Wikipedia (https://en.wikipedia.org/wiki/Spalart-Allmaras_turbulence_modell ).

Advanced3.2.2.6

Image 3.20 Dialog Box Simulation Parameters, Tab Advanced
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Surface Roughness Parameters

If the texture of the model surfaces has a major effect on the results, activate the Consider surface
roughness check box. The roughness will then be taken into account for every surface of the model.
Specific boundary conditions are applied to the surfaces or zones, providing surface constraints on the
turbulent viscosity to account for roughness effects.

The approach to surface roughness in CFD models is described in the OpenFOAM User Guide . The
modifications of surface functions for roughness are illustrated at https://youtu.be/
vYbRUmVTmGM .

For the program to determine the turbulent viscosity near the surfaces, the Sand-grain roughness height
Ks needs to be specified. You can define the size of the sand grains in the text box. Note that the value
is to be entered in meters.

The Roughness constant Cs controls the shape and spacing of the sand grains. This parameter is set as
0.5 by default, assuming a homogeneous distribution. If there is a non-uniform roughness, though, Cs
can be increased up to 1.0.

Relaxation Factors

In RWIND 2, it is possible to set relaxation factors for the OpenFOAM calculation. The relaxation
factors are closely related to the stability and the convergence of the calculation. In general, the
relaxation factors specify the amount by which a quantity changes from the previous iteration to the
next one. There is no effect at all for the factor equal to 1 and the effect is increasing as the relaxation
factor approaches zero. The limiting case of 0 represents a case where the solution does not change
at all with the successive iterations. Therefore, the admissible value of the relaxation factor should be
greater than 0 and less than or equal to 1.

An optimum choice for the relaxation factor is the one that is small enough to ensure stable
computation, but large enough to move the iterative process forward quickly.
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Info3.2.2.7

Image 3.21 Dialog Box Simulation Parameters, Tab Info

After the simulation, the last tab contains the information on the mesh and on the drag force sums of
both the original and the simplified model. If there are major differences between those sums, it is
advisable to increase the level of detail (see the Chapter 'General' below).

Edit Model3.2.3

You can modify some general settings of the model in a dialog box. To open that dialog box,
double-click the RFEM/RSTAB Model item the Data navigator or select Model on the Edit menu.
Alternatively, double-click the model in the work window.
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General3.2.3.1

Image 3.22 Dialog Box Edit Model, Tab General

Model Name

For imported models, the description RFEM/RSTAB Model is shown in the text box. You can enter any
description to characterise the model.

Model Type

In general, the structural model which you have imported from RFEM or RSTAB represents the Primary
model. It includes all objects of the Dlubal application where the wind is to be applied, such as
surfaces, beams, solids, and openings. Each project must have exactly one primary model. When
generating wind loads for RFEM/RSTAB, the primary model is set to the RFEM/RSTAB model data
imported from the Dlubal application (see the Chapter 'Settings' ).

Secondary model type

In addition to the primary model, the RWIND project can include other models that affect the flow
around the primary model. In practice, those secondary models represent surrounding buildings or
terrain, for example. Such models can be imported from external files (*.stl) or defined in the
RFEM/RSTAB model by means of visual objects or CAD/BIM models (see the Chapter 'Settings' ). If
you have imported a secondary model, you can position it by drag-and-drop operations or rotate it by
using a dialog box or graphical manipulator (see the Chapter 'Edit Objects' ).

The Terrain Model is a special type of secondary model that differs from other models in two things:

(a) It can be used as boundary condition, that is, the bottom boundary of the computational domain.

(b) Drag forces are not calculated for this model.
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If the project contains multiple models, the Drag Force Sum displayed in the legend of the work
window (see the Chapter 'Sums of Drag Forces' ) represents the sum of the forces applied to all
models except for the terrain. The drag force of each individual model can be found on the Info tab of
the Edit Model dialog box which belongs to that model (see the Chapter 'Info' ).

Image 3.23 Terrain Model Used as Boundary Condition (Imported from STL File)

The 'M_21BuildingWithTerrain' project in the Demo folder features an example of a terrain model.

Model Simplification

The Simplify model option is set as default. It means that small corrections of the RFEM/RSTAB model
required at, for example, boundaries or corners are done automatically by RWIND (see the Chapter
'Computational Mesh and Model Simplification' ). You can control the Level of detail of this
simplification by specific levels. Use the slider to adjust it from 0 (very coarse modelling of details with
a wide mesh) to 4 (many details with a very fine mesh). The default value 2 represents a good
compromise between simplification of the model and calculation speed. Click [Apply] to view and
check the simplified model based on a new level of detail.
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Image 3.24 Model with Levels of Detail 0 (top) and 4 (bottom)

As a reference, the Detail size of the meshing is shown in the text box below.

The mesh is automatically refined around the model subjected to the wind flow, which contributes to
higher calculation efficiency.

Depending on the geometry of the model, it is not always possible to apply high levels of detail. Level
'4' settings can slow down the program considerably or may cause insufficient memory errors.

High levels of detail can produce extremely fine or large meshes. It is then recommended to apply an
Optimisation to the mesh in which its shape is preserved. The [Settings] button enables you to control
the parameters of this optimisation. A new dialog box appears where you can set the upper and lower
limits of the mesh cells to be created.

Image 3.25 Dialog Box Simplified Model Optimisation
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The Close openings smaller than option enables you to control how openings in the model are to be
treated. 0% is preset. That means that all openings or gaps are considered for the analysis. The level of
closing openings can either be modified as percentage or set as absolute value. It is thus possible to
neglect small openings and simplify the model. Furthermore, window or door openings which are
closed in the real model can be easily filled with this feature.

Image 3.26 House with Closed Openings

If a beam model represents the structural model of a framework whose surfaces (cladding or roof
covering) are not explicitely included in the model, those surfaces are not contained in the imported
model of RWIND either. As a matter of consequence, the wind load will be applied only to the
members, not to the surfaces lying in between. The Close openings function is not suitable in this case
to replace the surfaces: loads on FE nodes would be created, which cannot be exported to the beam
model. They would be missing in the framework.

Since the automatic detection of openings is a demanding topological task, it may be necessary to
adjust openings manually.
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Position3.2.3.2

Image 3.27 Dialog Box Edit Model, Tab Position

In this tab, the Transformation of the RFEM/RSTAB model is specified. The parameters of displacement
(dX, dY, dZ) and rotation (A1, A2, A3) refer to the origin defined in the Dlubal application, taking into
account the wind direction of the relevant load case and the size of the wind tunnel.

The Scaling options enable you to change the model size in one or more directions. S1 is the axis in
the wind direction, S2 transversal to it, while S3 represents the vertical axis. If you want to scale the
model uniformly in all directions, select the Lock aspect ratio option.

In a similar way, the Skewing parameters enable you to distort the model. K1 is the axis in the wind
direction, K2 transversal to it, while K3 represents the vertical axis for rotation.
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Info3.2.3.3

Image 3.28 Dialog Box Edit Model, Tab Info

The last tab contains information on the dimensions of the model and on the mesh. After the calculation,
the drag force sums of both the original and simplified model will be listed, too.

Repair Model3.2.4

RWIND is able to correct small discrepancies within the model, such as nodes located very close to
other ones. To apply this function, select Repair Model on the Edit menu. Those corrections may only
be required when using non-simplified models. Simplified models do not need to be repaired this way.

Image 3.29 Dialog Box Repair Model
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Model Information

In this dialog box section, you can review the number of points, cells, open edges and non-manifold
edges. When you click the [Repair model] button, those numbers will change, depending on the
geometry of the imported model: the improved model will have less points and open edges.

Parameters

The Tolerance for merging points controls the limit spacing for close points. If the tolerance is below this
value, the points will be merged into a single one.

List of Corrections

There are three options in this dialog box section to control which items are to be improved: points
and/or mesh. It is recommended to select every one of them.

As mentioned above, the [Repair Model] function tries to improve the model layout. The modifications
will not yet be applied to the model, however. You can try different limits and review the results shown
in the Model Information section. When you are certain that you want to adopt the changes, click
[OK] or [Apply].

Edit Objects3.2.5

When the Model view is set, the panel provides some options to modify the position of the model. It
can be moved, rotated, resized, or clipped.

Image 3.30 Options Edit Objects in Panel

You can also access those functions on the Edit menu.
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Orient Primary Model3.2.5.1

Image 3.31 Dialog Box Model Orientation

You can modify the Rotation angle to adjust the orientation of the model towards the wind inlet. A
positive value rotates the model about the positive direction of the global Z-axis.

The dimensions of the wind tunnel are adjusted automatically to the rotated model when you have
selected the corresponding option. When you have selected the Dynamic update of view(s) option,
you can review the rotation angle in the work window.

Manipulate Model3.2.5.2

Select the model before applying the function.

Image 3.32 Options to Manipulate Position and Rotation in Panel and Work Window

You can modify the Position and/or Rotation of the model either numerically by entering the values in
the text boxes or graphically by using the arrows shown around the model. The parameters of
displacement (pX, pY, pZ) and rotation (A1, A2, A3) refer to the axes of the wind tunnel: pX and A1
are the coordinates or angles in wind direction, pY and A2 the ones transversal to it, while pZ and A3
represent the vertical coordinate or angle.

When the Local CS option is selected, all axes refer to the coordinate system of the original model of
RSTAB/RFEM. If the model is derived from load case 'Wind 90°', for example, the coordinate system
will be rotated by 90°.

Alternatively, you can move or rotate the model in the work window by selecting one of the arrows
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and moving it. The corresponding parameter is shown in the Current Value and Step box of the panel.
There you can also set the interval Δ for the model to snap on when moving the pointer. To deactivate
the graphical tool, click the empty space in the work window.

Click [Apply] to check in the graphics whether you have set the correct parameters. [Stop] or [Esc] will
cancel the function.

The wind tunnel is not adapted automatically to the new situation. Use the 'Wind Tunnel' dialog box
where you can adjust its dimensions to the new position of the model.

Resize Model3.2.5.3

Select the model before applying the function.

Image 3.33 Options to Resize Dimensions in Panel and Work Window

You can modify the Dimensions of the model either numerically by entering the values in the text boxes
or graphically by using the arrows shown around the model. The parameters of displacement (dX, dY,
dZ) refer to the axes of the wind tunnel: dX is the axis in the wind direction, dY the one transversal to it,
while dZ represents the vertical axis. If the dimensions are entered manually, the centre of gravity is
retained when resizing.

Please note that the axes refer to the original model of RSTAB/RFEM. If the model is derived from
load case 'Wind 90°', for example, the local coordinate system will be rotated by 90°.

Alternatively, you can resize the model in the work window by selecting one of the arrows and moving
it. The corresponding parameter is shown in the Current Value and Step box of the panel. There you
can also set the interval Δ for the model to snap on when moving the pointer. To deactivate the
graphical tool, click the empty space in the work window.

Click [Apply] to check in the graphics whether you have set the correct parameters. [Stop] or [Esc] will
cancel the function.

The wind tunnel is not adapted automatically to the new situation. Use the 'Wind Tunnel' dialog box
where you can adjust its dimensions to the new size of the model.

Be careful when manipulating models that have been imported from RFEM or RSTAB. The modified
sizes will not be exported back to the Dlubal application!
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Graphical Manipulator3.2.5.4

Select the model before applying the function.

Image 3.34 Options to Transform Objects in Panel and Work Window

The panel and the work window provide the previously described features for you to manipulate the
model: Translation or Rotation (see the Chapter 'Manipulate Model' ), Scaling and Skewing (rotating
about an axis with changing coordinates of only one direction – see the Chapter 'Resize Model' ).
Alternatively, you can modify the model in the work window by selecting one of the arrows and
moving it. The corresponding parameter is shown in the Current Value and Step box of the panel.

The wind tunnel is not adapted automatically to the modified model. Use the 'Wind Tunnel' dialog
box where you can adjust its dimensions to the new conditions.

Be careful when manipulating models that have been imported from RFEM or RSTAB. The modified
sizes will not be exported back to the Dlubal application! To avoid model inconsistencies, only
manipulate models that you have imported from *.stl files for simulations independently of RFEM or
RSTAB.

Drag-and-drop

Models can also by moved (or copied) by using drag-and-drop operations, which can sometimes be
easier than using the graphical manipulator.

The standard drag handle of a model is indicated by small sphere visible when the model is
preselected. When the [Alt] key is pressed, all available handles are displayed: Blue spheres at each
side of the model and small orange spheres at the position of the pointer. Select the most suitable one.

When dragging the model, release the [Alt] key. For the graphical pointer to snap to another model,
press the [Alt] key again. As soon as you approach the target model, blue and orange help points are
displayed for a suitable placement, which allows for an easy alignment.
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Image 3.35 Aligning Objects During Drag-and-Drop

To copy a model, press [Ctrl] when dropping the model.
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Move Along a Vector3.2.5.5

With the Move Along a Vector function, you can move or copy selected models by defining a vector.
Moving or copying models graphically is described in the Chapter 'Graphical Manipulator' .

Image 3.36 Dialog Box Translate - Copy

Define the Vector of Translation by entering the distances dX, dY, and dZ. You can also use the
button to define the vector in the work window by clicking two points.

When the number of copies is set to 0 in the Copy section, the selected model is moved. Otherwise, the
defined number of copies is created at the stated steps. If copies are generated, you can control the
Numbering of the new objects by clearing the Automatic check boxes.

When copying models, you can create Connections Between Copies. Select the check box and click
the [Details] button to open another dialog box with useful options to manipulate the objects.

Image 3.37 Dialog Box Manipulations Options
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Clip Model3.2.5.6

The Clip Model function enables you to cut off parts of the model.

Image 3.38 Clipping Box for Cropping Model

When you have activated the function, the model is encased within a 3D box whose sides can be
adjusted by the arrow tools. The functions correspond to those used to adjust the wind tunnel (see the
Chapter 'Wind Tunnel' ). The Box coordinates displayed in the panel enable you to control the size in
detail.

Click the [Apply Clipping] button to crop all parts of the model that are not contained in the box. To
cut off the parts within the box, however, activate the Invert option before clipping.

Watch this video to see how a model can be clipped.

Note that the Clip Model function deletes parts of the model. If you want to create visibilities of specific
parts, for example to assign zones, use one of the Cut options in the toolbar list.
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Image 3.39 Options Cut in Toolbar

When a model is clipped, the triangular meshes are trimmed. This approach may lead to imperfect
results for cases when closed surfaces are not fully recognized. The tool (which is part of the VTK
library) is not 100% perfect, but still very useful so that its advantages outweigh the shortcomings.

Zones3.2.6

By means of zones, you can subdivide the model into parts and assign specific properties, such as
materials with their roughness parameters. Zones are also useful when you want to examine the local
surface results of components inclusive of their drag forces.

To manage the zones, select the Zones tab in the work window. The panel Editor is automatically set
to the management of zones. When you have imported the model from RFEM/RSTAB, the materials
defined in the Dlubal application are preset in the Zones section of the panel.

Watch this video to see how materials are converted into zones.

Image 3.40 Zones

The triangular mesh elements are displayed on the model. You can assign elements to the preset
zones. If you want to define a new zone, click [New Zone] in the Edit Zones section of the panel.
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Image 3.41 Dialog Box New Zone

In the New Zone dialog box, enter the Name of the zone. You can select one the existing materials
from the list to assign its roughness parameters. The button enables you to define a new material. If
you do not change the preset No Material option, the global roughness parameters will be applied to
the new zone.

To allocate mesh elements to a zone, use one of the options in the Selection Tools section of the
panel. You can either select the triangle element(s) first and then click on the zone in the panel, or
select the zone first and then assign the triangle(s).

The Selection Tools buttons have the following functions:

Button Function

Selects a single triangle element when clicking it with pointer

Selects several elements when moving brush over them

Selects several elements when drawing a rhomboid over them

Selects several elements when drawing a circle from a selected centre

Selects several elements when defining a free polygon around them

Table 3.1 Selection Tools buttons

Note that the elements of all planes intersecting with the projection of the defined area will be
included, too. If you want to select the elements of only one plane, use the Section Commands
functions first to hide irrelevant objects.
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Image 3.42 Section Commands

All zones are listed in the Sections tab of the navigator (see the Chapter 'Sections' ). When you select
a zone, this part of the model is displayed exclusively while all other parts of the model are hidden.

Mesh Refinements3.2.7

The FE mesh is generated with the global mesh size resulting from the level of detail (see the Chapter
'General' ) and the mesh density in due consideration of possible boundary layers (see the Chapter
'General' ). For specific areas of the model, however, you can influence the mesh generation by
defining FE mesh refinements.

You can create a mesh refinement by means of the Insert menu or the Mesh Refinements shortcut menu
of the navigator. The Mesh Refinement dialog box is opened.

Image 3.43 Dialog Box Mesh Refinement

If required, enter a Comment that makes it easier to identify the refinement. In the Mesh Density section,
you can define the target length of the mesh cells so that the refinement is adequate to the critical area.
Then, specify the position and size of the box-shaped refinement area in the Location and Dimensions
section. You can also use the [Adjust Graphically] option to define the refinement in the work window.
The functions of the graphical manipulator correspond to those used to adjust the wind tunnel (see the
Chapter 'Wind Tunnel' ).

The Anchor Point is a reference point defined in the local coordinate system and is related to the
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coordinate system of the model. It ensures that the mesh refinement is linked to the model; for example,
if the model is rotated, the mesh refinement is rotated, too.

Materials3.2.8

By means of a material, you can assign a surface roughness to a model or to specific parts of it. It will
affect the surrounding flow field.

To define a new material, open the Insert menu and select New Material. You can also use the shortcut
menu of the Materials item in the navigator.

Image 3.44 Dialog Box New Material

Enter the Name of the material. To consider its specific surface roughness, select the check box in the
Surface Roughness Parameters section. You can then define the Sand-grain roughness height Ks (the
size of the sand grains) and the Roughness constant Cs. For more information on the surface roughness
parameters, see the Chapter 'Advanced' .

You can then assign the material to either a model or to specific parts of the model, the so-called Zones
(see the Chapter 'Zones' ).

Image 3.45 Assigning Material to Model or Zone
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For the program to consider the surface roughness, make sure that the corresponding check in the
Advanced tab of the Simulation Parameters dialog box is activated (see the Image 'Simulation
Parameters' ).

If you have defined models or zones with different materials, the hierarchy of the surface roughness is
as follows: The global roughness defined in the Simulation Parameters dialog box is applied to all
objects unless it is overridden by the material properties of each model. The highest priority, though,
have the zones with the assigned materials.

User-Defined Models3.3

In the current version of the program, it is not yet possible to create user-defined models. This feature
will be available in upcoming releases.

RFEM/RSTAB Window3.4

At the present stage, models can only be created in the Dlubal applications RFEM and RSTAB whose
settings concerning the wind load simulation are to be defined in a specific window. Based on those
parameters, load cases are created which can then be analysed by RWIND.

To access the 'RWIND window' in RFEM or RSTAB, select Tools RWIND - Simulate and
Generate Wind Loads on the menu.

This function is available for 3D model types only.

Image 3.46 Accessing the Simulate and Generate Wind Loads window in RFEM

The Simulate and Generate Wind Loads window opens which consists of four tabs.

Wind Load

Load Cases

3 Input Data

54



RWIND - User Manual

www.dlubal.com

Settings

Surface Roughness

Wind Load3.4.1

Image 3.47 Window Simulate and Generate Wind Loads, Tab Wind Load

In this tab, you can define the common parameters that are relevant to determine the wind load.

The Chapter 'Wind Speed Profile' gives you some general information on the application of wind
loads.

Wind Directions

This tab section controls the wind directions which will affect both the wind exposure of the model and
the number of generated load cases. The angle φ to set the wind directions refers to the positive global
X-axis of the model. The rotation is defined clockwise about the positive Z-axis.

You can apply a Uniform division of the wind rose by equidistant steps Δφ. The finer the division steps
are, the more load cases will be created. Define the start angle φA (0° is aligned to X-axis) and the
end angle φB of the distribution.

Alternatively, you can apply Manually defined directions: enter the values of the angles and separate
them by semicolons. To save user-defined directions, click the button and enter a description. Click
the button to import a user-defined list of wind directions.
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Wind Profile

In this section, you can define the parameters of the wind velocity and turbulence. There are two
options for the wind velocity.

According to Standard

The wind load is determined over the height of the building, depending on standard-specific
parameters. The standards EN 1991-1-4 [1] , ASCE/SEI 7-16 [2] , and NBC 2015 [3] are
available for selection. The Image above illustrates the parameters associated with EN 1991-1-4.
When a different standard is set, the content of this section is adjusted to the regulations of the code.

Image 3.48 Wind Velocity According to ASCE/SEI 7-16 [2]

For EN 1991-1-4, select the National Annex. If applicable, you can set the relevant Wind zone. Use
the button to open a map showing the wind zone of your country.

Image 3.49 Wind zones of the Netherlands

When you double-click a location on the map, the corresponding wind zone will be set in the list.
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Select the terrain Category in the list. Depending on your National Annex, different categories are
available.

For some National Annexes, the wind velocity is also dependent on the Altitude HS of the terrain. The
value can be entered manually.

As the result of all parameters, the Fundamental wind velocity vb,0 is displayed. The wind profile is
calculated from this value, taking into account the overall height of the model. According to
EN 1991-1-4 [1] , 4.2, this value is the characteristic 10 minutes mean wind velocity, irrespective of
wind direction and time of year, at 10 m above ground level in open country terrain with low
vegetation such as grass and isolated obstacles with separations of at least 20 obstacle heights.

You can review the wind velocities of every level in the left table below and left chart to the right.

Instead of the fundamental wind velocity, you can Consider the mean velocity. According to EN
1991-1-4 [1] , 4.3, the mean wind velocity vm(z) at a height z above the terrain depends on the
terrain roughness and orography. It is determined according to EN 1991-1-4 [1] , Expression (4.3).
This accounts for the fact that effects of peak velocity pressure appearing on the model are considered
by a specific wind tunnel simulation, which allows for the application of lower mean velocities. When
this option is activated, the table and chart are updated.

The profiles of the mean velocities vm are specified in the National Annex for Germany, Table NA.B.2.
for the four terrain categories, for example.

The Density of the air is dependent on the altitude, temperature, atmospheric pressure, and humidity. It
has an effect on the dynamic behaviour of the fluid.

User-Defined

You can define any wind profile not represented by the available standards in a table sheet. Enter the
Level z and allocate the corresponding Wind Velocity. [Enter] creates a new table line for the next
level.

The [Import from MS Excel] button enables you to import a specific pressure curve from an active Excel
sheet.

The velocity diagram is displayed dynamically in the left chart.

The buttons below the table have the following functions.

Button Function

Opens a dialog box where you can select a user-defined wind profile

Opens a dialog box where you enter a name for the current wind profile to save it

Exports the current wind profile to MS Excel

Imports a wind profile from MS Excel

Restores the default settings

Opens the Windows calculator where you can compute values

Table 3.2 Buttons for user-defined diagrams
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User-Defined Turbulence

The check box and table are accessible when the Use uniform turbulence option to consider turbulence
is disabled (see Section 'Turbulence Properties' below). Here you can define any turbulence profile
in a table sheet. Enter the Level z and allocate the corresponding Turbulence Intensity. [Enter] creates a
new table line for the next level.

The [Import from MS Excel] button enables you to import a specific turbulence curve from the active
Excel sheet. The other buttons below the table are described in the Table above .

The turbulence intensity diagram is displayed dynamically in the right chart.

Turbulence Properties

For the calculation with RWIND, the effects of turbulence are essential. If you want to Consider
turbulence, activate this option. The effects of turbulent flow are characterised by chaotic changes of
pressure and flow velocity, contrasting laminar flow. For further explanation, see the Chapter
'Turbulence' .

The Model of turbulence can be based on the correlations between k and epsilon or k and omega.
The first option is set as default. Depending on the selection, you can specify either the turbulent
dissipation rate ε or the specific dissipation rate ω. In some cases, the simulation using kω is more stable
than the one using kε.

The fluctuating component of the wind is represented by the Turbulence intensity defined in EN
1991-1-4 [1] , 4.4 or ASCE/SEI 7-16 [2] , 26.11.4, for example. It is the standard deviation of the
turbulence divided by the mean wind velocity. The recommended rules are given in EN 1991-1-4
[1] , Expression (4.7) or ASCE/SEI 7-16 [2] , Eq. (26.11-7).

When the Use uniform turbulence at the inlet option is set, you can define the intensity I as a global
percentage, that is, the ratio of root-mean-square of the turbulent velocity fluctuations and the averaged
velocity at the same location over some time period. An idealised flow of air with absolutely no
fluctuations in air speed or direction would have a turbulence intensity value of 0%. For high-turbulence
cases, the turbulence intensity is typically between 5% and 20% (see CFD Online ). The turbulence
intensity is set to 1% by default to cover most medium- and low-turbulence cases. When you deactivate
the Use uniform turbulence at the inlet option, you can define the turbulence intensity at specific height
levels in the User-defined Turbulence table (see Section 'Wind Profile' above).

The Terrain level option controls which part of the building is exposed to the wind. The default value is
zero, which means that the wind flows around the lowest point of the model. If the model contains a
basement storey or foundations, for example, the terrain level should be adapted accordingly. The
value refers to the orientation of the global Z-axis: if it points upwards, a positive value moves the
model downwards. If the Z-axis points downwards, however, you have to enter a negative value.
The terrain level represents a global value, that means, it is not possible to define an inclined terrain.
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Load Cases3.4.2

Image 3.50 Window Simulate and Generate Wind Loads, Tab Load Cases

The second tab of the Simulate and Generate Wind Loads dialog box gives you a list of the generated
load cases and their descriptions. The result depends on the wind directions that you have previously
defined in the Wind Load tab. If you have set a uniform, fully circular arrangement at angles of 45°,
for example, eight load cases are created as seen in the Image above .

By default, the first free load case number is used as the initial one. If necessary, use the 'Settings'
tab (see below) to set a different number for the first wind load case to be generated.

The Calculated column shows you whether results of RWIND are available (you need to calculate a
load case first, see the Chapter 'Calculation in RFEM/RSTAB' ).

You can enter a Comment to describe the parameters of each load case, for example.

The [View Mode] button at the end of the table enables you to jump to the work window and check
the directions of the wind loads. As described above, the angle φ refers to the positive global X-axis,
with a clockwise rotation about the positive Z-axis.

The functions [Calculate All in Background] and [Calculate LC in Background] are described in the
Chapter 'Calculation in RFEM/RSTAB' . They will execute a 'silent' analysis of all load cases or of the
selected one, respectively. The [Open in RWIND] button, however, calls up the RWIND program.
There you can view the model and its location within the wind tunnel. You can also check whether the
mesh settings are adequate (see the Section 'Model Simplification' and the Section 'Finite Volume
Mesh' ) and adjust the parameters, if necessary.

Before applying [Calculate All in Background], you should check the transfer of the model and its
simplification in RWIND. Calculate one load case and follow the progression of the residual pressure.
Then examine the plausibility of the results. It might be necessary to adjust the wind tunnel, FE mesh,
level of detail, etc. When everything has been verified, a 'blind' analysis of all load cases in the
background may be justified.
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Settings3.4.3

Image 3.51 Window Simulate and Generate Wind Loads, Tab Settings

Flow Parameters

The value of the Kinematic viscosity describes the resistance of the air to deformation. It is defined as
the ratio of the viscosity to the density of the air.

Finite Volume Mesh Settings

The Density of mesh to be applied around the model is controlled by percentage reference. This
specific refinement is utilised for the model simplification and the flow calculation. The default density
(20%) normally results in a relatively low number of finite volumes and a relatively fast calculation. The
minimum percentage is 10%. It entails a rather coarse mesh with the smallest number of volumes. The
higher the density of the mesh, the smaller the size of the finite volume cells will be. The results are
accordingly more precise, but the calculation will need more time due to the greater number of
volumes. Setting the maximum mesh density (100%) leads to very fine meshes with millions of volumes.
The calculation of 3D flow on such meshes is on the edge of the capabilities of current PCs, with a
calculation time of several hours to several days.

For further information, see the Chapter 'Computational Mesh and Model Simplification' .

The Boundary layers option controls whether the finite volume mesh next to the surfaces of the model is
refined in a special way. This refinement gives better results near the boundaries of the model (see the
Image 'Finite volume mesh with five boundary layers' ). It is highly recommended to activate the
boundary layers and define the number of layers NL when the surface roughness is to be taken into
account.

The Level of detail controls the simplification of the model in RWIND where specific corrections of the
RFEM/RSTAB model are required at, for example, boundaries or corners (see the Image 'Model with
levels of detail' ). You can define levels of detail between 0 (very coarse modelling of details with a
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wide mesh) to 4 (many details with a very fine mesh). The default value 2 represents a good
compromise between simplification of the model and calculation speed. Alternatively, you can define
the Detail Size manually.

Generated Load Case Properties

In this section of the dialog box, you can set the Number of the first load case to be created. By
default, the first unused number is set.

The Keep RWIND results if mesh is deleted option enables you to preserve the loads created by
RWIND when the RFEM/RSTAB model is modified afterwards. No new calculation by RWIND will be
required if you change some material, adjust the support conditions, or apply other modifications
which do not have an impact on the CFD analysis.

As the loads of the RWIND are connected to mesh points, the results of the CFD analysis which are
needed for RFEM/RSTAB are stored within the model data. It means that the RWIND results are
always part of the model when this option is enabled. If the mesh is deleted in RFEM due to some
modification, the loads created by RWIND can be extrapolated to the new situation without running a
new CFD analysis. There may be greater loads on fewer elements, for example. If a member or
surface is deleted, its loads will be lost.

To apply the RWIND results that are still available in the background after having modified the RFEM/
RSTAB model, use the [Calculate LC in Background] or [Calculate All in Background] buttons. Do not
use [Open in RWIND]. A warning is shown before the results will be redistributed.

Image 3.52 RWIND Warning

All results will nevertheless be deleted if some calculation parameter is changed in the 'RWIND
window'.

If there is any significant topological change of the model, the Keep RWIND results if mesh is deleted
option must not be used. The loads cannot be adequately distributed across the geometry of the new
model. For this reason, the feature is disabled by default. Reusing the internal RWIND results can be
justified only if the old and new meshes do not differ significantly. The final decision must be taken by
the user.

To clear the temporary data existing in the background, use the [Delete RWIND Results] button in the
'Load Cases' tab .

Calculation Parameters

The Maximum number of iterations does not mean that all iterations actually have to be carried out: If
the calculation converges with less iterations, it is stopped. This option can be useful to avoid infinite
loops or apply short calculations for testing purposes.

The Convergence criterion represents the stop limit for the calculation. As soon as the residual pressure
falls below this limit, the calculation is terminated. Note that no less than 300 iterations are carried out,
however.

When you activate the Use Potential Flow to calculate initial conditions option, a linearised version of
non-viscous Navier Stokes equations is used to generate the start conditions.

The Use second-order numerical scheme check-box controls which numerical scheme is used for
divergence terms (fluxes). It is not activated by default so that the calculation is carried out according
to first order. The first-order numerical discretization generally yields better convergence than the
second-order scheme. The second-order discretization is usually more accurate, however.
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Model Properties

The Close openings smaller than option enables you to control how openings in the model are to be
treated. By default, RWIND takes account of all openings or gaps in its analysis. This means that
openings that you have modelled for, for example, windows or doors are assumed as open surfaces.
To close these openings, you can enter their Absolute size as a limit. Alternatively, the value of that limit
can be defined as a Percentage of the model size. The Image 'House with closed openings' shows
the result of that feature applied to the simplified model of RWIND.

Make sure to close the surfaces of imported beam models. Otherwise the wind load will be applied
only to the members.

As the automatic recognition of openings is a demanding topological task, it may be required to adjust
openings manually.

Turbulence Model Properties

This window section is accessible when the Use uniform turbulence at the inlet option has been
activated in the Wind Load tab (see the Chapter 'Wind Load' ).

By default, the Calculate turbulence parameters from the intensity of turbulence option is set. This
means that the parameters k and ε (or ω, depending on the selected model of turbulence) are
determined automatically from the global turbulence intensity value defined in the Wind Load tab.
When you clear the check box, you can define the parameters manually in the text boxes below. The
Turbulence kinetic energy represents the mean kinetic energy characteristic for eddies which is
produced by fluid shear or friction. The Rate of dissipation of turbulence energy describes the
deduction of energy due to the airflow. When you have the selected the 'k-omega' model of turbulence
in the Wind Load tab (see the Chapter 'Wind Load' ), you can specify the Specific rate of dissipation
of turbulence energy instead.

For detailed information on turbulence kinetic energy, see CFD Online .

Member Load Distribution

The settings of this window section have an effect on the load application of the generated member
loads on the model.

Concentrated: The loads result in concentrated loads at relative distances along every member. The
intervals of the load application points are usually very small, depending on the density of the mesh.

Uniform: For every member, constant loads are created along the member length. Only one uniform
member load is applied for each global direction.

Trapezoidal: Similar to uniform loads, the concentrated loads are levelled along the member. They
are converted into a trapezoidal distribution, however, to approximate the actual gradients.

In many cases, the Uniform distribution is accurate enough.
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Image 3.53 Result of Three Options for Column Member (Concentrated, Uniform, Trapezoidal from Left to Right)

Export to RWIND

For the export of the RFEM/RSTAB model, the Export optimized member topology option is set by
default. It means that member elements are converted into simplified sections of the RWIND model.
Every cross-section is replaced by a rectangular section which encompasses the outlines of the original
one. By means of this simplification, the meshing of the member is less detailed so that the simulation
can be performed much faster. For further details, see FAQ 4165 .

Image 3.54 Optimised member topology (left) versus original topology (right)

If want to analyse the objects contained in the current Visibility (see Chapter 9.9.1.2 of the RFEM
manual ) instead of the entire model, select the Export active objects only option.
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Terrain Model Exported to RWIND

The Export Terrain model option enables you to use the terrain geometry defined in the Dlubal
application for the simulation. In RFEM and RSTAB, you can model terrain features by means of
importing visual objects (see Chapter 11.3.9 of the RFEM manual ). Specify the number(s) of the
relevant Visual objects representing the terrain model that are to be exported for the analysis. The
button clears the list of defined numbers, while the All option applies all visual objects. In the RWIND
program, the terrain model type will be allocated accordingly (see image to the left). For more
information on the Terrain Model, see the Chapter 'General' .

It is likewise possible to consider neighbouring buildings or other relevant objects in the simulation.
Select the Export Surrounding model option and specify the number(s) of the Visual objects that are to
be exported. Additionally, you can export CAD/BIM models which have been defined in the
RFEM/RSTAB model (see Chapter 12.2.2 of the RFEM manual ). The BIM workflow using IFC files is
described in detail in a Knowledge Base article . In the RWIND program, both surrounding models
and CAD/BIM models will be classified as secondary models (see the Chapter 'General' ).

Image 3.55 Exported Surrounding and CAD/BIM Models
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Surface Roughness3.4.4

Image 3.56 Window Simulate and Generate Wind Loads, Tab Surface Roughness

If the texture of the model surfaces has a major effect on the results, activate the Consider surface
roughness check box. You can then select whether the roughness is taken into account for All model
surfaces or applied According to materials.

For the program to determine the turbulent viscosity near the surfaces, the Sand-grain roughness height
Ks needs to be specified. You can define the size of the sand grains in the text box or table column for
each material. Note that the value is to be entered in meters.

The Roughness constant Cs controls the shape and spacing of the sand grains. This parameter is set as
0.5 by default, assuming a homogeneous distribution. If there is a non-uniform roughness, though, Cs
can be increased up to 1.0.
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Calculation4

RWIND4.1

When you have used the [Open in RWIND ] button in the Simulate and Generate Wind Loads window
of RFEM or RSTAB, the RWIND program is started. You can see the model and the wind tunnel in the
work window. Before you start the simulation, you ought to check whether the parameters applied to
the CFD analysis are appropriate.

Checking Parameters4.1.1

Wind tunnel

The outline of the wind tunnel is displayed as a box around the model in its centre. You can check the
wind direction which is symbolised by a big red arrow. In the View navigator, several options are
available to display some items relevant for the wind tunnel (see image to the left). The terrain level
results from the value defined in the Model Properties section of the General Data window.

If necessary, you can adjust the size and position of the wind tunnel graphically or in the Wind Tunnel
dialog box (see the Chapter 'Wind Tunnel' ). Make sure that enough space is provided at all sides of
the model for the air to flow unimpededly.

Openings

If you have selected the Close openings option (see Section 'Model Properties' ), you can check
whether the openings or gaps are adequately closed in the model of RWIND. If necessary, you can
modify the settings in the 'Edit Model' dialog box of RWIND. Note that it will make a considerable
difference for the analysis whether the air can flow through an opening or not.

Simplified model

RWIND features a Simplified Model, which is created from the original RFEM/RSTAB model. It
represents a special mesh to define the model boundary (see the Chapter 'Computational Mesh and
Model Simplification' for further information).

You can display the simplified model as follows:

Select the Show Simplified Model option in the panel.

Select the Simplified option in the View navigator for the Model display.
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Image 4.1 Options to Display Simplified Model in View Navigator and Panel

The degree of simplification is controlled by the Level of detail specified in the 'Edit Model' dialog
box . The Chapter 'General' includes an example which shows the effects of this value on the
'shrink-wrapping' process applied to model. If the boundaries are not represented properly, you can
adjust the level. When you click [Apply] in the 'Edit Model' dialog box , you can immediately check
the modifications and view the new simplified model. Note that a very detailed model will accordingly
require more computational time.
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FE Mesh4.1.2

Surface Mesh and Finite Volume Mesh4.1.2.1

As described in the Chapter 'Computational Mesh and Model Simplification' , two types of meshes
are used for the simulation. The simplified model is 'shrink-wrapped' by a mesh of the boundaries which
again provides the basis of the 3D volume mesh around it. The former represents the so-called Surface
Mesh, the latter the Volume Mesh.

When the calculation of results is started (see the Chapter 'Calculation' ), the mesh is created
automatically. To create the mesh separately, however, select Generate Mesh on the Simulation
menu.

The Edit Bar - Simulation panel provides specific options to display the two types of meshes.

Show Surface Mesh

Image 4.2 Surface Mesh of Model

Select this option to check whether the Mesh Density set in the 'Simulation Parameters' dialog box
gives an adequate representation of the original model. Furthermore, the Level of Detail set in the 'Edit
Model' dialog box strongly influences the quality of the surface mesh. If the simplified model
appears too coarse or extremely fine, you should modify the level of detail.

In the View navigator, you can control the display of Mesh Faces (the filled mesh surfaces) and Mesh
Edges (separation lines between mesh elements) – see Image 4.1 .
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Show Volume Mesh

Image 4.3 Volume Mesh of Wind Tunnel

The volume mesh can be displayed in a so-called Slicer plane. It gives a section through the wind
tunnel which is parallel to one of the global planes (XY, YZ, XZ). For more information on handling the
tool, see the Chapter 'Slicer' . You can distinguish between the refined volume mesh at the model
boundaries and the wider mesh at distant locations.

Mesh Refinement4.1.2.2

The finite volume mesh can also be controlled by mesh refinements. This feature enables you to define
rectangular areas about objects for local in-depth analyses of the wind flow, for example.

To create a new mesh refinement, select New Mesh Refinement on the Insert menu, or use the shortcut
menu of the Mesh Refinements item in the Data navigator. The Mesh Refinement dialog box is opened.
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Image 4.4 Dialog Box Mesh Refinement

In the Mesh Density section, you can set the target length of the mesh cells within the refinement. The
size and location of the box-shaped refinement area is to be defined in the Location and Dimensions
section below; the dimensions in X, Y and Z refer to the origin. The [Adjust graphically] button enables
you to define the size of the area in the work window – similarly to the function to adjust the wind
tunnel (see the Chapter 'Wind Tunnel' ).

To get a notion of the adequate cell size within the refinement, check the size of the global mesh
elements in the 'Simulation Parameters' dialog box .

When the parameters have been set, you can generate the mesh and check its shape. The 'M05_Golf'
model in the Demo project group, for example, shows two mesh refinements defined for the side
mirrors of the car.

Image 4.5 Mesh Refinements at Side Mirrors
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Calculation4.1.3

Start Calculation

In the RWIND program, you can start the calculation with the following options:

Select Start Calculation on the Simulation menu.

Select Calculate Results in the panel.

You can follow the progression of the mesh generation and calculation in the panel.

Image 4.6 Progression of Calculation Shown in Panel

The simulation iteratively determines the Residual Pressure until either the convergence criterion is
satisfied or the maximum number of iterations is reached. Those limits are controlled by the Simulation
Parameters settings (see the Chapter 'General' ).

The Residual Pressure diagram is also available after the calculation (see the Chapter 'Residual
Pressure' ).

Stop Calculation

You can interrupt the simulation at any time by clicking [Stop Calculation], for example to obtain the
results at a specific residual pressure, or when there is no convergence. The results are then created for
the current iteration (i.e. the next iteration after the interruption) and will be available for evaluation.

To proceed with the calculation, click [Continue Calculation] in the panel. This function is also
available when the simulation was accomplished normally. In the Continue Calculation dialog box,
you can then specify the new limit of iterations and/or convergence criterion.
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Image 4.7 Dialog Box Continue Calculation

This means that you can interrupt the calculation at any time, look at the intermediate results and
continue the simulation if you wish. You can also increase the number of maximum iterations if the
calculation was finished without having reached the stated residual. Note that the Continue Calculation
function is not available after having closed the project.

If the [Stop Calculation] function does not terminate the calculation within 30 seconds, the text of the
button is changed to [Cancel Calculation]. You can then use this button to abort the simulation. The
Cancel Calculation function is also available in the Simulation menu. It immediately terminates all
running calculation processes and deletes the temporary files. No results will then be available.

Show Log Files

All calculation steps are recorded in a log file. To open this file, click the [Show Log Files] option, which
is available in the Display Options of the panel or in the Simulation menu. The Log Files dialog box
appears where you can check the details of each calculation step. If the calculation is running, the
dialog contents and log files are continuously updated.

Image 4.8 Dialog Box OpenFOAM Log Files

Pressing the [Open File Location] button opens the Windows File Explorer. The working directory
where the log files are located is shown.

4 Calculation

72



RWIND - User Manual

www.dlubal.com

Notes

The calculation time largely depends on the global Mesh Density (see the Chapter 'Simulation
Parameters' ) and the Level of Detail set for the simplified model (see the Chapter 'Edit Model' ).

For an effective and fast calculation, RWIND applies a parallel approach by using the cores of your
computer in an optimal way. You can check the calculation settings in the Program Options dialog box
which you can access via the Options menu.

Image 4.9 Dialog Box Program Options, Tab Program

Interruption and Continuation of the Calculation

Ongoing steady-flow and transient-flow calculations can be interrupted, the current results can be
viewed and then the calculation can continue. The results of steady-flow calculation can be used for
both the continuation of steady-flow and transient-flow calculations.

Troubleshooting4.1.4

Although OpenFOAM® computational modules are stable and have been verified by thousands of
users over the past 15 years, it should be remembered that simulations of 3D turbulent flow are a non-
linear mathematical problem that does not always have to converge. In RWIND, we consider the
numerical solution to be correct when the residual pressure drops below 0.001. This usually occurs
within 500 iterations, but sometimes the calculation ends without reaching the desired residual value.
There may be a number of reasons for this and there is no universal solution, but we will try to give
some advice on how to proceed:

Use the Continue Calculation function with a greater number of maximum iterations to see if the
solution continues to converge or not.

Increase the external dimensions of the computational domain, i.e. the boundaries of the wind tunnel.
Automatically set dimensions may sometimes be insufficient, especially behind the model (i.e.
downstream).

Increase the density of the Finite Volume Mesh in the 'Simulation Parameters' dialog box or the
Level of detail for simplified models in the 'Edit Model' dialog box .

Try to simplify and optimise the model:
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If the model has openings (such as windows, doors, and so on) through which the flow can enter
inside the model, try closing them (assuming you do not want wind flow inside the model).

Remove small details in the model which have little or no influence on the simulation results.

Buildings should be placed correctly on the floor of the wind tunnel or beneath this level. If the
model is placed above the tunnel floor with a thin empty space between the model and the
tunnel floor, the analysis may crash.

It can be assumed that the solution is acceptably converged when the following criteria are met:

The number of iterations executed is greater than the minimum number set by default (currently: 300,
see the Image 'Program Options' ).

The residual pressure is below the limit value set by default (currently: 0.001, see the Chapter
'General' ).

The graph of the residual pressure over time no longer changes (or only very little), or it periodically
oscillates around a certain mean value (see the image below ).

Image 4.10 Residual pressure of solution with oscillating values
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Batch Calculation for Multiple Wind Directions4.1.5

RWIND 2 provides the feature of the automatic generation of simulations for multiple wind directions
and the subsequent batch calculation of them. This option was and still is available in RFEM / RSTAB,
but now, it is also available in the RWIND stand-alone program. The procedure is as follows:

Prepare a project with all input parameters for the simulation and with zero rotation of the model.

Open the dialog box for generating copies of the project with the rotated models.

Start the batch calculation from Project Manager.

Copies of Project with Rotated Model4.1.5.1

The dialog box for generating rotated models can be opened from the main menu using the command
Edit Generate Projects for Multiple Wind Directions. In the dialog box, it is first necessary
to set the number of wind directions, their rotation, and names for new tasks. Then, press the Update
Cases button to fill in the table with the final list of the new projects. You can then edit or modify the
data in the table. The actual generation of projects is then performed when clicking the Generate
Simulation Casesbutton.

Image 4.11 Dialog Box Generate Simulation Cases

Batch Calculation of Selected Tasks4.1.5.2

The RWIND Project Manager enables batch calculations, where the selected projects are
automatically opened, calculated, saved, and closed one by one. This allows you, for example, to run
the time-consuming calculations overnight. Each calculation in the batch takes full advantage of the
number of cores / processors set in the Program Options dialog box (that is, the calculation internally
runs parallel). The calculations are performed sequentially because each calculation requires a
relatively large amount of RAM and running multiple calculations simultaneously could result in a lack
of memory and a drastic slow-down of the calculation. However, in the future versions of RWIND, we
plan to add the ability to run multiple calculations simultaneously.

To start the batch calculation, open the Project Manager, select the projects for the calculation and
press the [Calculate in Batch] button.
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Image 4.12 Dialog Box Project Manager

Then, another Batch Calculation dialog box appears, where you can click the [Start Calculation]
button. This starts the step-by-step calculation of tasks, with the status of the tasks being displayed in the
table.

Image 4.13 Dialog Box Batch Calculation

Calculation in RFEM/RSTAB4.2

In the Simulate and Generate Wind Loads window of RFEM or RSTAB, you can start the calculation in
the Load Cases tab (see the Chapter 'Load Cases' ). When you click the [Open in RWIND] button,
you call up the RWIND program. There you can check the simulation parameters, such as the shape of
the simplified model, wind tunnel, etc. If all settings are accurate, you can start the calculation as
described in the Chapter 'Calculation' above.

The [Open in RWIND] function gives you a 'backstage inspection' of the simulation. This feature is
recommended to calculate one load case in order to verify and calibrate the simulation parameters, if
necessary.

At the end of the calculation, you have to decide whether to close RWIND and return to RFEM/RSTAB
or continue studying the results in RWIND.
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Image 4.14 RWIND Message After Calculation

To start the calculation without opening RWIND, use one of the [Calculate] functions.

Calculate All in Background

When you click this button, the 'silent' calculation of all load cases by RWIND is started in the
background. For every load case, the progression of the simulation is shown in a panel.

Image 4.15 Calculating All in Background

The results are finally transferred to RFEM/RSTAB and the RWIND panel is closed.

If you want to run a simulation for specific objects of your model, apply a Visibility for them (see
Chapter 9.9.1.2 of the RFEM manual ) and select the Export active objects only option in the Settings
tab (see the Chapter 'Settings' ). Then [Calculate All in Background] to apply the analysis to only
those objects in the model of RWIND.

Calculate LC in Background

When you click this button, only the load case selected in the table is relevant for the simulation.
RWIND performs a 'silent' calculation, but you can follow the progression of the simulation in the
panel.
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Results5

Results in RWIND5.1

The CFD results are displayed immediately after the calculation. If you do not want to quit RWIND,
select [No] for the question shown in the Image 'RWIND message after calculation' . You can then
examine the results in RWIND.

When RWIND is closed, the results of the project (model file) can be viewed again by using the
Project Manager of the program (see the Chapter 'Project Management' ).

Types of Results5.1.1

After the simulation, different types of results are available for evaluation. They can be accessed in the
Data navigator, the Results menu, or in the panel by clicking the entry.

Image 5.1 Types of Results Available in Navigator, Menu Results, and in Panel

Viewing results on model

Use the scroll wheel of your mouse to move, rotate or zoom the model. When you press the wheel
button, you can move the model within the workspace. When you press both the wheel button and the
[Ctrl] key, you can rotate the model (alternatively, press the wheel button and hold down the right
mouse button). Zooming is possible by turning the mouse wheel, as usual. The symbol of the pointer
illustrates the selected function.
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Surface Quantities5.1.1.1

The results that are related to the surfaces of the model are displayed as Surface Quantities. Those
include the surface pressure and Cp coefficient results. You can set the type of results by clicking the [P]
or [Cp] button in the Results - Surface Quantities area of the panel.

Surface Pressure

Image 5.2 Surface Pressure

By default, the pressure due to the wind acting on the surfaces is displayed as a Color Map: to every
point on each surface, a pressure value is allocated. The colour assignment classifies the locations
within surfaces that have specific pressure magnitudes. In the panel, the colours and respective values
are represented.

The pressure acts perpendicularly on the surfaces, thus showing you drag (positive magnitudes) and lift
(negative magnitudes).

When you activate the Show Drag Forces option in the panel or navigator, you can review the
resulting force of the wind load acting on the model and its location.
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Image 5.3 Surface Pressure with Resulting Drag Force

If required, you can modify the colours and assigned values (see the Chapter 'Colour Map' ).

When you activate the Results on Finite Volume Mesh option in the panel or navigator, the surface
pressure results are displayed on the mesh featuring the finite volumes used for the calculation. Thus,
you can check how openings or connections of beams are treated in the simulation, for example.

Image 5.4 Results on Finite Volume Mesh
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Surface Cp Coefficient

Image 5.5 Surface Cp Coefficient

These values show the pressure coefficients which represent the relationship between the static pressure
and the stagnation pressure. The definition of the Cp coefficient can e.g. be found at https://
en.wikipedia.org/wiki/Pressure_coefficient , with the freestream velocity V∞ assumed as value
occurring at the top edge of the model.

Flow Field Quantities5.1.1.2

The results that are related to the finite volume mesh of the model are displayed as Flow Field
Quantities. Those include the pressure field, velocity field and turbulence field results. You can set the
type of results by clicking the [P], [U], [k], or [ε] button in the Results - Flow Field Quantities area of the
panel.
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Pressure Field

Image 5.6 Pressure Field

The pressure field represents a section through the wind tunnel which illustrates the wind pressure
distribution of the air flow. Drag is represented by positive magnitudes, lift by negative ones.

The section is presented in one of the global planes (XY, XZ, YZ) that can be controlled by the
corresponding buttons in the toolbar. To evaluate pressure fields at specific sections through the model,
use the Slicer options described in the Chapter 'Slicer' .

Image 5.7 Pressure Field in Horizontal Slicer Plane (XY)
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Velocity Field

Image 5.8 Velocity Field on Simplified Model (Mesh Faces and Edges Disabled)

The velocity field represents a section through the wind tunnel illustrating the wind speed distribution. It
enables you to evaluate the scalar field of wind velocity on your model.

The section is presented in one of the global planes (XY, XZ, YZ) that can be controlled by the
corresponding buttons in the toolbar. To evaluate velocity fields at specific sections through the model,
use the Slicer options described in the Chapter 'Slicer' .
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Turbulence - k Field

Image 5.9 Turbulence - k Field

These results show a section through the wind tunnel illustrating the distribution of turbulences with
respect to the turbulence kinetic energy k (see the Chapter 'Turbulence' ). By moving the slicer plane,
you can examine the effects of turbulence at specific locations.

Turbulence - Epsilon Field

Image 5.10 Turbulence - ε Field

5 Results

84



RWIND - User Manual

www.dlubal.com

Alternatively, the ε field results of the turbulence can be displayed.

Velocity Vectors5.1.1.3

Image 5.11 Velocity Vectors

The velocity vectors within a slicer plane represent a collection of arrows featuring specific magnitudes
and directions. The arrows are attached to discrete grid points in the plane. By the velocity vectors, you
can evaluate both the wind speed and the direction of air flow around the model.

To display velocity vectors at specific sections through the model, use the Slicer options described in
the Chapter 'Slicer' .

The View navigator provides three options for you to modify the vector display: Line (shows or hides
vector lines), Arrow Head (shows or hides vector heads), Uniform Size (scales or levels vectors). If the
latter option is disabled, the arrow lengths and thicknesses of heads reflect the magnitudes of each
wind velocity.
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Image 5.12 Velocity Vectors with Disabled Option Uniform Size

Streamlines5.1.1.4

Image 5.13 Streamlines

Streamlines are a fine tool to study the characteristics of the air flow. They represent a composition of
curves that are tangent to the velocity vector (see above), showing the direction in which a massless
fluid element will travel at any point in time (see explanation at https://www.grc.nasa.gov/WWW/
k-12/airplane/stream.html ).
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The colours visualise the speed of the particles moving through the wind tunnel. The associated
velocities are explained in the panel.

For a vivid visualisation of the air flow, activate the Streamlines Animation in the panel or on the Results
menu. You can then watch the fluid particles flowing around the model and examine their speeds and
directions.

The graphical settings of the streamlines are controlled in a separate section of the panel. You can
access it by clicking Streamlines Settings in the panel or on the Options menu, pointing to Streamlines.

Image 5.14 Streamlines Settings in Panel

Control Points Source

The streamlines refer to control points that are created automatically. You can modify the number of
points with the slider.

By default, the control points are located within a 3D Box. It is possible to select a different type of
source from the list (see image to the left), but those options are only relevant for specific evaluations.

When the Show Manipulator option is enabled, you can change the size and location of the 3D box
graphically in the work window. The functions of the arrows correspond to those for modifying the
wind tunnel (see the Chapter 'Wind Tunnel' ). Click [Apply] to transfer the new settings.

Particle Animation

Use the Animation option to switch the display of the animated view of the streamlines in the work
window on or off.

By default, the flow of the particles is displayed as Lines. When you select the Particles option from the
list, you can examine the direction and speed of the particles around the model.

5 Results

87



RWIND - User Manual

www.dlubal.com

Image 5.15 Animation Type Particles

To modify the settings of the animated streamlines, click the [Animation options] button. Alternatively,
open the Options menu, point to Streamlines and select Streamlines Options. The following dialog box
is opened.

Image 5.16 Dialog Box Streamlines Options

Streamlines

The Display streamlines when animating movement of particles option controls whether the lines are
shown when the Particle type of animation has been selected (see above). Furthermore, it is possible to
increase the Line thickness of the streamlines display. The Calculation of streamlines is effectuated both
Downstream and Upstream by default. The former option enables you, e.g., to visualise effects of drag,
the latter to display lift in detail.
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Animation of Particles and Flowlines

In this section of the dialog box, you can control the Count (number), Size (thickness), Length, or Speed
of the particles and streamlines utilised for the animated display. Use the slider to increase or reduce
the individual parameters.

Click [Apply] to review modified settings in the animated view without closing the dialog box.

Member Forces5.1.1.5

Image 5.17 Member Forces

With this option, you can examine the forces acting on the members of the model. Each arrow reflects
the size and direction of the force determined for a specific location along the member. The display of
the forces is without values.
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Residual Pressure5.1.1.6

Image 5.18 Graph Showing Residual Pressure

During the calculation, the diagram of the residual pressure is shown (see the Image 'Diagram of
iterations and residual pressure' ). It is a logarithmic chart which is also available for inspection after
the calculation.

The residual pressure illustrates the progress of the applied pressure during the iterative simulation
process. Starting from an initial value of the pressure, the simulation refines the residuals with every
iteration, trying to reduce the imbalance of the pressure in the finite volume. The lower the residuals
become, the more accurate the solution will be. The simulation terminates when the convergence
criterion or the maximum number of iterations has been reached (note that no less than 300 iterations
are always carried out). Thus, the residual pressure represents an important tool to judge the
convergence of the simulation.

You can control the iterative calculation with the settings in the Simulation Parameters dialog box (see
the Chapter 'Simulation Parameters' ).

To resize the Graph of residuals and iterations, move the window frames accordingly.

Use the [Print] button to print the diagram. The Windows Print dialog box appears where you can
specify the printer and its settings.

When you click the [Edit] button, the Graph Settings dialog box is opened. There you can adjust the
layout of the Curves, for example.
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Image 5.19 Dialog Box Graph Settings for Modifying Layout of Curves

If the Residual Pressure diagram reveals any problem concerning convergence, you should review the
Simulation Parameters (mesh density, convergence criterion) and the Wind Tunnel . For the latter,
the default size is set as small as possible to obtain short calculating times. If its length in X-direction is
too short (especially the area behind the object), effects of divergence and, thus, oscillating values of
residual pressure may arise. In that case, extend the wind tunnel accordingly. For more details, see the
Chapter 'Troubelshooting' . In specific cases, however, osciallating results are correct when they are
within a consistent bandwidth without increasing. This effect is illustrated in the simulation of a cylinder
model at https://youtu.be/A4WaC2V-3uA and explained in FAQ 4731 .

Sums of Drag Forces5.1.1.7

Image 5.20 Drag Force Sums of Original and Simplified Models
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In the lower part of the graphical window, the Legend indicates the check sums of the drag forces.
They represent the resultants of the wind load in the global directions X, Y, and Z. You can compare
the drag forces acting on the Original Model and on the Simplified Model. If there are considerable
differences, you ought to increase the level of detail in the Edit Model dialog box for a more refined
simplified model (see the Chapter 'General' ).

Graphical Display of Results5.1.2

Instant Results During Calculation5.1.2.1

During the transient flow calculation, it is possible to graphically display instant results, including the
values in point probes and drag forces. The display of instant results can be enabled on the main page
of the dialog box with the simulation parameters.

Image 5.21 Instant Results During Calculation

Results on Time Layers, Master Time Layer5.1.2.2

The results of the transient flow can be displayed in the same way as the results of the steady flow,
while the results for a certain selected time layer are displayed. The current time layer can be selected
in the combo-box or using the scrollbar located on Edit bar. The Master time layer, used for exporting
results to RFEM / RSTAB, is marked with the Master suffix in the combo-box and can be set in the
pop-up menu by clicking the Time Layer Options and Commands button located on Edit Bar. Here, it is
also possible to start the flow animation, in which the displayed time layers change automatically. In
the flow animation mode, the flow can be smoothed by linear interpolation between two-time levels.
This option can be turned on/off using the Smooth Flow Animation command available in the pop-up
menu after clicking the Time Layer Options button located on Edit Bar.
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Image 5.22 Time Layer Options and Commands

Graphs of Drag Forces in Time5.1.2.3

RWIND 2 allows you to display a graph with the time development of the drag forces acting on
models or any of their parts. The graph shows the drag-forces for all saved mesh sections, which can
be seen in the Sections navigator panel. Since the mesh sections are automatically generated for all
models and zones, there are always the graphs with drag forces available for such objects (unless a
user turns off this automatic generation). However, you can also create custom mesh sections from any
part of the mesh of the original or simplified model, and then display the graphs with drag forces for
these mesh sections as well. The graph allows you to display multiple curves according to the current
selection in the list box in the dialog box with the graph.
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Image 5.23 Dialog Box Transient Flow Results, Drag Forces

Graphs of Quantities in Time5.1.2.4

These graphs show the time development of quantities (pressure, velocity and Cp coefficient) at the
points of the given probe. The probes are divided into three groups according to the type of the mesh
on which its points are located: a flow field mesh, an original model mesh, a simplified model
mesh. For the probes defined before the calculation, the curve values are taken from the stored
transient-flow data for the probes (Chapter 3.2.2.3 of the RFEM manual - paragraph Saving Results),
while for the other probes (additionally created or modified), the curve values are taken from the
stored transient flow data for the whole domain.

The exceptions are point probes on the original model, whose curves are always plotted from
transient-flow data for the entire domain. This is due to technical reasons associated with extrapolating
the pressure on the original model. The curves lying on the original model have another peculiarity,
namely the case where the original model consists of a flat plate, which has two different result values
at one point (for example, different pressure on the front and back side of the plate). In such cases, two
different curves are plotted in the graph and are marked with a special suffix Front and Back.
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Image 5.24 Transient Flow Results, Point Probes

The names of curves in the graph correspond to the numbering of the probe points, which can be
displayed in the graphics according to the attached figure.

Image 5.25 Current View, Point Probes

Graphs for Given Time Layer5.1.2.5

When displaying graphs with the distribution of quantities along a curve or on a line-probe, the values
from the current time layer are displayed. This time-layer can be changed on Edit Bar without having to
close the graph window. It is also possible to start the flow animation, and then the curve displayed in
the graph automatically changes according to the time layers. The graph also allows you to display all
curves (for all time levels at once).
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Image 5.26 Graph Along Curve

Slicer5.1.3

All scalar field results, such as Pressure Field and Velocity Field , as well as the Velocity Vectors
are displayed in a Slicer plane. It represents a planar section through the air flow within the wind
tunnel.

Image 5.27 Slicer Plane Showing Pressure Field Results
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By default, the slicer plane is located in the centre of the wind tunnel and aligned parallel to one of the
global planes (XY, XZ, YZ). You can change the plane by clicking the corresponding button in the
toolbar.

To move the slicer to a different position, use one of the four bullets shown in the corners of the slicer
plane (Slicer Plane Handle, see the image above). When you pull the plane along a wind tunnel line,
the results are dynamically updated for the new slicer plane.

If you need an inclined plane to evaluate the results, select the Clipper tab of the panel. Either define
the Rotation about the relevant axis manually in the corresponding panel section or select the Show
manipulator option in the Clipper Settings section to adjust the plane graphically.

Image 5.28 Slicer Plane Showing Velocity Field Results for Surface Non-Parallel to Global Plane; Tab Clipper with Options to Adjust Slicer

Use the arcs shown in the slicer centre to rotate the plane about its longitudinal or transversal axis. The
corresponding angle is updated in the panel.

Activate the Cascade option in the Slicer Options section of the panel to create a group of parallel
planes ('slices') within the wind tunnel. You can define the distance between each by clicking the
[Options] button. Alternatively, use the Slicer Options in the Options menu to open the corresponding
dialog box.
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Image 5.29 Dialog Box Slicer Options

In the Slicer Cascade section, you can define the unit distance between each parallel plane by an
Absolute value or a Relative parameter (the effective distances are controlled in the Clipper tab by
means of the Step factors).

The Options section controls the maximum number of parallel planes. It is a global setting which is
applied to all projects.

Image 5.30 Cascade of Slicer Planes
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Display Options5.1.4

RWIND provides several features for you to control the graphical user interface and to specifically
evaluate the results.

Graphical User Interface5.1.4.1

The display options control how objects are displayed in general: colour and layout of lines, font of
numbering, and so on. In the View navigator, however, you can decide whether specific objects are
shown or not.

On the Options menu, point to Display Options and select Edit to open the following dialog box.

Image 5.31 Dialog Box Display Options

Select the relevant object in the Category tree. You can then adjust the colour, line type, font of
numbering, etc. in the Parameters section. The parameters depend on the selected item.

As the settings are managed separately for the Screen and Printer, you can make specific adjustments
for the work window and for your documentation.
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Scalar Fields5.1.4.2

Via the Scalar Fields options available in the View navigator, you can display the results values related
to every point of the model in different ways. As an alternative, select the display option from the list
button in the toolbar. Please note that the type of display must match the type of result: For example,
isosurfaces representing 3D finite volume mesh results cannot be applied to 2D surface pressure
results.

Image 5.32 Color Map Display of Surface Pressure

The Color Map display option is set by default. It fits all types of results and model display as it is
adapted automatically. In the panel, the eleven principal colours with the corresponding values are
represented. You can adjust both colours and values, if necessary (see the Chapter 'Colour Map' ).

Isolines represent lines of points with equal results. By default, eleven colours are allocated to lines
featuring values at equidistant intervals. Isolines can be useful for printing graphics to a monochrome
printer.

Isosurfaces are surfaces featuring identical values of the 3D finite volume mesh output. That option can
be used to display pressure field and velocity field results.

The Color Edges and Color Points options illustrate the results of the 3D finite volume mesh. Thus, they
are useful to display the pressure field and velocity field results by means of coloured mesh lines or
coloured mesh nodes, respectively.
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Image 5.33 Color Edges Display of Velocity Field

If the Min/Max Values option is enabled, the extreme values of the selected type of result are shown.
Ordinary values can be displayed by moving the pointer across a surface or within the slicer plane.

Depending on the selected type of results, the Solid/Transparent Model view or the Wireframe Model
view is advantageous to evaluate the results. You can also select the model display option from the list
button in the toolbar.

Image 5.34 Color Points Display of Pressure Field for Wireframe Model
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Clipper5.1.4.3

Sections through the model can be created by means of a Slicer or a Clipper. Select one of the
Clipper options available in the Clipper Settings section of the panel to activate it. With the Clipper -
Plane option, the results of the zone behind (or in front of) the cutting plane are displayed. As an
alternative, you can apply a Clipper - Box to examine the results on the surfaces of a box-shaped
cutout.

The clipper options are only suitable for 3D finite volume mesh output, such as pressure field or velocity
field results.

Image 5.35 Results in Clipper - Plane Display

The settings options of the Clipper tab correspond to those of the Slicer . You can modify the clipper
plane graphically via one of the four bullets shown in the corners of the section plane. When you pull
the clipper plane along a wind tunnel line, the results are updated dynamically.
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Colour Map5.1.4.4

The Edit Bar tab of the panel includes a colour scale with the assigned ranges of values. Eleven colour
zones are set by default. They cover the range between the minimum and the maximum values in equal
intervals.

To adjust the colour scale, double-click one of the colours. You can also use the shortcut menu of the
colour scale where you select Edit Scale and Colors.

Image 5.36 Dialog Box Edit Color Scale

Use the vertical sliders to the right of the values to reduce the number of colour ranges at both ends of
the colour scale. To change a specific colour, double-click it. Then, select a different colour in the
familiar Colour dialog box.

You can adjust the scale values individually, but make sure that you follow the ascending or
descending order. The buttons in the Permanent Scales section help you to assign the values
automatically and save the new settings for other projects.

By increasing the values in the Number of Intermediate Isolines section, you can obtain a more refined
output of isolines or separation lines.
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Color Scale in Each View

When displaying the results graphically in RWIND 2, it is possible to display the Color Scale in each
view-window or to have one common scale on the Edit Bar. It is possible to switch the position of the
Color Scale, for example, from the pop-up menu after right-clicking the scale or in the dialog box for
editing the color scale.

Displaying the color scale inside the view saves space on the edit bar (which can be especially useful
on smaller monitors); another advantage is the presence of a color scale on a video recorded using
the function: Main Menu Tools Create Video File.

Image 5.37 Dock Color Scale

Named Views5.1.4.5

You can save and import user-defined views with specific viewing angles, zoom factors, or items
selected in the View navigator. Those so-called Named Views make it easier for you to evaluate the
results. They correspond to the “User-defined views” of RFEM/RSTAB as described in Chapter 9.9.1 of
the RFEM manual .

To store the present view of the model or simulation, select Save Current View on the View menu.
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Image 5.38 Save Current View

Enter a View Name to denote the current display settings and click [OK] to save the view.

To restore the settings of a specific view, select Edit Named Views on the View menu.

Image 5.39 Dialog Box Edit Named Views

Activate the Display selected option and then select the relevant view in the Saved Views section.

Reduced Domain5.1.4.6

For large models, it can be difficult to graphically evaluate the results associated with specific
locations. The Show Reduced Domain option enables you to view the results of a limited area within
the wind tunnel. Activate this feature in the Display Options of the panel where you can also access the
settings.
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Image 5.40 Displaying Results of Reduced Domain

This option is available for all types of results except for surface pressure. With it, you can confine the
graphical output to relevant parts of the model.

To adjust the size of the reduced domain box, select the Edit Reduced Domain option in the Results
section of the panel. You can then modify the dimensions in the panel which provides the
corresponding options. As an alternative, use the arrows displayed within the domain box to resize it.
The functionality corresponds to the features described in the Chapter 'Wind Tunnel' : when you hold
the [Shift] key while moving an arrow, the box is modified symmetrically in the respective direction. By
holding the [Ctrl] key, you can scale the area up or down uniformly in all three directions.
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Image 5.41 Modifying Reduced Domain

Probes5.1.4.7

RWIND provides an option to define locations for results at specific points on the model or within the
wind tunnel around it. Those control points are called 'probes'. They can be used to evaluate and
manage the result values for both surface and flow field quantities. Those numerical results defined for
the RWIND model are also used for the documentation of results in the printout report of RFEM or
RSTAB (see the Chapter 'Printout Report' ). Probes can be defined for points and lines (see the
Chapter 'Chart Along Line' ). All sets of probes are shown in the navigator tree.
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Point probes can be inserted by means of the Insert menu or the [Insert Probe Points] button which is
available in the Current Point Probe section of the panel.

When the function has been activated, the relevant points can be selected by mouse-clicks. The
coordinates of the points are displayed in the panel which has a specific layout for this purpose. There
you can also modify the object snap, if necessary. When you have selected all points, click [Finish].

Image 5.42 Graphical Definition of Mesh Value Probe Points

The current sample of probe points is denominated 0 - Temporary. To save it permanently, use the
[Save Probe Copy] button below the list of point probes. A new dialog box appears where you can
define the Name of the probe and check the coordinates of each point.

Image 5.43 Dialog Box New Point Probe
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The options of the Data Source Mesh section control to which type of mesh the probes refer to (see the
Chapter 'Computational Mesh and Model Simplification' ). Probes are specific to three categories of
data source meshes:

Original Model – display of surface quantities on surface mesh (i.e. Results of Finite Volume
Mesh option disabled)

Simplified Model – display of surface quantities on finite volume mesh

Flow Field – display of flow field quantities on finite volume mesh

For example, the flow field results (pressure field, turbulence, and so on) require different locations of
probes than surface results (surface pressure, Cp coefficient).

Image 5.44 Probes of Pressure Field Results Defined on Finite Volume Mesh
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Image 5.45 Probes of Surface Pressure Results Defined on Surface Mesh

All probes, that is, both temporary and saved sets of probes, will be exported to RFEM/RSTAB and
can be included in the printout report.

The buttons in the Current Point Probe section of the panel (see image to the left) have the following
functions.

Button Function

Deletes all point probes of the current probe set in the list

Adds new points

Saves current set of points

Option to check and modify current probe

Option to control whether all probes are shown in graphics or only current one

Table 5.1 Buttons for Probes
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Graph Along Line5.1.4.8

The Graph Along Line function enables you to define a line on the model or in the slicer plane and,
thus, create a sectional diagram of the results along the line. The 'M05_Golf' model in the Demo
project group, for example, includes some line probes for the flow field results of the car model.

To create a line graph, use the [Graph Along Line] button which is available in the Results section of
the panel. Note that this function is only applicable to the surface and flow field quantities.

When the function has been activated, you can select the relevant points of the line (or polyline) by
clicking the mouse. The coordinates of the points are displayed in the panel which has a specific layout
for this purpose. There you can also modify the object snap, if necessary. When you have selected the
two (or more) points of the line, click [Finish].

Image 5.46 Defining Line for Graph and Line Probe

The Graph Along Curve dialog box is shown.
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Image 5.47 Dialog Box Graph Along Curve

To define this diagram as new Line Probe, use the [Save] button. Another dialog box appears where
you can enter the Name of the probe and check the coordinates of each point.

Image 5.48 Dialog Box New Line Probe

The options of the Data Source Mesh section control to which type of mesh the probes refer to. Line
probes are specific to the finite volume mesh of either the flow field (for flow field quantities) or the
simplified model (for surface quantities), see the Chapter 'Probes' .

All user-defined line probes are listed in the Data navigator. Use the shortcut menu of a line probe,
which is available both in the navigator and graphics, to display the diagram and to modify or delete
an item.
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Image 5.49 Line Probes in Navigator, Shortcut Menu in Graphics

The results of every line probe are saved by points along the line. Note that they will not be used for
the documentation of results in the printout report of RFEM or RSTAB.

Front and Back Values Along Curves

A new feature in RWIND 2, compared to RWIND 1.x, is the option to display the distribution of
quantities along the curves or line-probes placed on the original model. This was not previously
possible due to the risk of double values (front and back) on some models (for example, on a thin
vertical plate with zero thickness). This problem has been solved by showing two curves in the graph in
such cases, one for the values on the front side and the other for the values on the back side of the
model.

Image 5.50 Probe Graph, Front and Back Values

5 Results

113



RWIND - User Manual

www.dlubal.com

Sections5.1.4.9

Sections can be applied to the surfaces of the model. They enable you to display parts of the result
meshes and obtain local results, for example the drag force acting on the section. Those results can be
examined for any part of a model, that is, for any subset of model triangles.

By means of sections, you can also control which parts of the topology are displayed. Parts can be
shown exclusively or hidden, similar to the 'Visibility' options available in RFEM/RSTAB.

The sections are managed in a separate tab of the navigator. By default, sections are created
automatically for the zones, each representing a material or part (see the Chapter 'Zones' ).

Image 5.51 Tab Sections with Zones to Control Visibility

To use the zones for the results, too, mesh-sections must be created. Click the [Commands] button. In its
menu, select the Generate Mesh Sections option. The Section Options dialog box appears. Click the
[Generate Sections] button and then close the dialog box.

Image 5.52 Generating Sections from Zones
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Now you can select a zone in the Mesh Sections list and examine its surface quantity results.

Image 5.53 Surface Pressure of Wall Mesh-Section

As you can see in the Image 'Generating sections from zones' , there are two types of sections:

1. Geo-Sections

Each model – primary or secondary – represents a geo-section. They are available when the
Model tab of the work window is selected. Use the [Commands] functions to create sections and work
with them.

Image 5.54 Functions Commands for Geo-Sections
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2. Mesh-Sections

The mesh-sections represent all zones that were created automatically or defined manually (see the
Chapter 'Zones' ). They are available when the Zones tab of work window is selected.

To modify or delete sections, use the [Manager] button.

Image 5.55 Deleting Section in Section Manager

Units and Decimals5.1.5

To adjust the units or decimal places used in the program, select Units on the Options menu.

Image 5.56 Dialog Box Edit Units
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Select the Current unit box of the unit you want to modify. Then use the button to open the list of
available units. Additionally, you can reduce or increase the number of Dec. places by entering a
different value.

Grid and Work Plane5.1.6

Grid points are useful when defining objects graphically. To open the settings of the grid, select Grid
and Work Plane on the Tools menu. Alternatively, use the toolbar button.

Image 5.57 Dialog Box Grid and Work Plane

The Work Plane can be parallel with one of the three global planes: XY, YZ, or XZ (the selection is also
possible by means of the toolbar buttons, that is, without opening this dialog box).

By default, the Grid Origin is located in the zero point. Use the button to select a different point in
the work window, or enter its coordinates. With the button, you can define a new reference point.

In the sections below, specific options are available for you to adjust the Grid Type (cartesian or polar
arrangement), Number of Grid Points and Grid Point Spacing, for example.
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Printing Graphics5.1.7

You can print every image that is currently shown in the work window.

Print Preview

Before printing the image to the printer or clipboard, you should check the preview. Select Print
Preview on the File menu to open a different window.

Image 5.58 Preview Window

The preview shows the current view of the work window, the colour scale, and the legend.

Use the [Options] button to open a dialog box where you can control specific settings for printing. This
dialog box can also be accessed by selecting Print Options on the File menu.

Image 5.59 Dialog Box Print Options, Tab General
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In the first tab, you can control the contents of the Print, the Page Orientation, and the Page Margins.

Image 5.60 Dialog Box Print Options, Tab Picture

The second tab controls the settings of the Print Quality (resolution), Colors and Frame (texts and lines
optionally in black for monochrome printers), Text Size (scaling factor if fonts are too small or too big),
as well as of the Symbol Size and Line Width (scaling factor for graphical objects). In most cases, it is
not necessary to change the default settings.

Please note that resolutions higher than 5000 x 5000 pixels together with a 32-bit colour depth may
result in data exceeding 100 MB, which is a problem for some printer drivers.

Image 5.61 Dialog Box Print Options, Tab Color Scale

In this tab, you can control the Orientation of the colour scale, the Drawing Options (frame, min-/max
info) and its Size as well as its Position (inside or outside of image, alignment, font).
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Image 5.62 Dialog Box Print Options, Tab Legend

In the final tab, you can activate up to four Legend Rows and allocate texts. The project information
and picture description are set by default. You can select different content from the list or insert
user-defined text, if necessary.

To review the modified settings, click [Apply]. If the Print Options are fine, close the dialog box. Then
use the [Print] button in the toolbar of the preview window to start printing.

Print

To start the printing process, select Print on the File menu or use the button in the toolbar.

The Windows Print dialog box is opened.

Image 5.63 Dialog Box Print

Select the Printer and define the Properties, if necessary. [OK] starts the print.
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Results in RFEM/RSTAB5.2

The Simulate and Generate Wind Loads window does not provide any results of the simulation. It
manages the data only relevant for the input. The output data created by the analysis of RWIND are
converted to loads which are then allocated to the respective load cases of RFEM or RSTAB.

To access the results of the simulation in the main program, close the Simulate and Generate Wind
Loads window by clicking [OK].

Load Cases5.2.1

In RFEM and RSTAB, select one of the load cases created by RWIND with the following options:

Data navigator: Load Cases and Combinations Load Cases

Toolbar: list of load cases

Table: 2.1 Load Cases

Menu: Edit Load Cases and Combinations Load Cases

Image 5.64 RWIND load cases in navigator, toolbar, and table

The descriptions of the RWIND load cases ('Wind x °') reflect the ones defined in the Load Cases tab
of the Simulate and Generate Wind Loads window (see the Chapter 'Load Cases' ).
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Loads5.2.2

The loads that were generated by RWIND are displayed as nodal loads and/or member loads on the
model. The numerical values are managed in Table 3.1 Nodal Loads exported from RWIND and
Table 3.2 Member Loads. When you double-click a load arrow in the graphics, a dialog box is
opened where you can review the parameters of that load.

It is not possible to modify any load value which is based on the analysis by RWIND.

Image 5.65 Dialog Box Edit Nodal Load
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Nodal Loads5.2.2.1

Image 5.66 RWIND Nodal Loads in Navigator Data, Work Window, and Table 3.1 Nodal Loads Exported from RWIND

For the surfaces of the model, nodal loads are created for all nodes of the FE mesh. Each load vector
is defined By components of the force in the global directions X, Y, and Z. The values of the constituent
forces PX, PY, and PZ are shown in the graphics, dialog box, and table.

Even for ordinary mesh sizes, a great number of loads is created at rather close distances. You can
disable the display of the load values via the button for a better view of the vectors. If necessary,
you can also adjust the scaling of the arrows in the Display Properties. This option is described in
Chapter 11.1.2 of the RFEM manual .

To evaluate the loads of an RWIND load case for the parts of the model in a better clarity, you can
use Visibilities (see Chapter 9.9.1.2 of the RFEM manual ).

If the FE mesh is deleted or modified, the nodal loads imported from RWIND will be deleted.

If you have used the Close openings option to fill openings for the simulation (see Section 'Model
Properties' ), please note that the loads acting on the closed parts of the model in RWIND are not
represented as nodal loads in RFEM. There is no algorithm which could redistribute those loads on the
parts around the openings.
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Member Loads5.2.2.2

Image 5.67 RWIND Member Loads in Navigator Data, Work Window, and Table 3.2 Member Loads

For the members of the model, concentrated, uniform or trapezoidal member loads are created,
depending on the specification in the Settings tab. The image above illustrates the results of a
uniform distribution. If the concentrated load distribution was set, many loads are created at close
relative distances along every member, depending on the density of the mesh.

The load values being rather small in most cases, they can be distinguished by increasing the number
of decimals or changing the unit to [N], for example. Select Units and Decimal Places on the Edit menu
to open the dialog box familiar from RFEM/RSTAB.

Image 5.68 Dialog Box Units and Decimal Places, Tab Loads for RFEM
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Types of Results5.2.3

Load cases created by RWIND can be calculated in the same manner as load cases containing user-
defined loads. For a detailed description of the calculation, see Chapter 7 of the RFEM manual .

After the calculation, the results are displayed graphically in the work window and listed numerically in
the tables.

Deformations and Internal Forces

Chapter 8 of the RFEM manual gives an overview of the different types of results. The evaluation of
the results is described in Chapter 9 of the RFEM manual . Use the Results navigator or the toolbar
buttons to display the deformations of surfaces and members or to select specific internal forces of
surfaces or members.

Image 5.69 Deformations of Load Case Containing Loads from RWIND

You can verify the plausibility of the applied wind loads by checking the global deformations, for
example. Table 4.0 Results - Summary gives you an overview of the sums of loads and support forces,
as well as of the global resultants (see the image above).

5 Results

125

https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/07
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/08
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09
https://www.dlubal.com/en/downloads-and-information/documents/online-manuals/rfem-5/09


RWIND - User Manual

www.dlubal.com

Distribution of Load

The Results navigator provides an option for you to evaluate the results of RWIND loads: Activate the
Distribution of load results and then select the Wind load using RWIND option.

Image 5.70 Distribution of Load Showing Local Forces fz in [kN/m2] Perpendicular to Surfaces

As described in Chapter 9.3.2 of the RFEM manual , the distribution of the forces on the finite
elements is displayed, which results from the defined loads. You can select the forces acting in one of
the Global directions (X, Y, Z) or Local directions of the surfaces (x, y, z). By displaying the RWIND
surface loads, you can adequately evaluate the results of the simulation.

The results of the load distribution are shown numerically in Table 4.53. They represent the results that
are available at the grid points of each surface.

Image 5.71 Table 4.53 RWIND - Distribution of Load

Note that the Distribution of Load feature covers the FE results of surfaces and solids, not of members.
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Load Combinations and Result Combinations5.2.4

You can combine RWIND load cases with common load cases in load combinations and result
combinations. The former incorporate the loads of the contained load cases, the latter of the results. For
a detailed description, see Chapter 5 of the RFEM manual .

Image 5.72 Dialog Box Edit Load Cases and Combinations, Tab Actions with Load Cases Generated by RWIND

RWIND load cases are classified as alternatively acting in the Wind action category. Wind load cases
never occur in two directions simultaneously.

Note that wind load cases usually only exist with self-weight. If the separate calculation of an RWIND
load case gives an instability, combine it with the self-weight load case.
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Printout Report5.2.5

In the global printout report of RFEM or RSTAB, the data of the 'RWIND window' are managed in a
specific chapter. Furthermore, the generated load cases and loads generated by RWIND are part of
the documentation by default. You can also include the graphical results, such as internal forces,
deformations or stresses, of any RWIND load case. For a detailed description of the printout report,
see Chapter 10 of the RFEM manual .

To include the RWIND data in the printout report, activate the RWIND Data option in the Global
Selection tab of the RFEM or RSTAB program.

Image 5.73 Dialog Box Printout Report Selection, Tab Global Selection

You can then select the specific data in three tabs.

RWIND Model Data

Image 5.74 Tab RWIND Model Data

In this tab, you can select which data defined in the Wind Load and Settings tabs of the 'RWIND
window' (see the Chapter 'Wind Load' and the Chapter 'Settings' ) is to be printed. The Graph of
the wind velocity and turbulence diagrams is each activated by default.
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RWIND Load Cases

Image 5.75 Tab RWIND Load Cases

This tab enables you to select the load cases created by RWIND (see the Chapter 'Load Cases' ).

For load cases that have been calculated, the Drag Force and Projected Area will be specified in the
table of the printout report.

Image 5.76 Chapter 2.1 Load Cases in Printout Report

Please note that the drag forces act on the original model, referring to the coordinate system of RFEM
or RSTAB. The projected area represents the area of all objects perpendicularly to the wind direction
(projection in plane).

RWIND Results

Image 5.77 Tab RWIND Results

In this tab, you can select which numerical results of RWIND are to be printed. Note that those are
only available for locations of 'probes' that have been defined for points (see the Chapter 'Probes' ).

Point probes are not based on any automatism in RWIND. They must rather be set by the user if any
numerical results are to be included in the printout report. Furthermore, probes are specific to load
cases. They are to be separately defined in RWIND for every single load case as the models depend
on the wind directions.

Temporary probes are denominated as “0” sets. Point probes that have been saved (see the Image
'New Point Probe' ) are designated by their numbers.

Please note that the results on the simplified model are given in the coordinate system of RWIND
(xRWIND, yRWIND, zRWIND).
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Image 5.78 RWIND Data in Printout Report
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Printing Graphics

The graphical results of every RWIND load case can be incorporated in the printout report, too.
Chapter 10.1.5 of the RFEM manual gives you detailed information on the printing options
concerning images.

Image 5.79 Load Distribution Graphic of RWIND Load Case
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